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CHAPTER 1

Introduction

AODC RAN DATA MANAGEMENT
At the end of each ship cruise, Royal Australian Navy (RAN) collected data
is forwarded to the Australian Oceanographic Data Centre (AODC) for
quality control (QC) and addition to the Navy’s Maritime Environmental
Database (MEDB). The variety of data collected by the RAN include:
Temperature Profiles
Meteorological
Seabed Composition
Bioluminescence
Water Transparency
Sound Velocity

Over the last 10 years the AODC has been using a number of different quality
control procedures to process all of the above data types. All of them have
been very labour intensive due to the manual process of quality checks
involved and the large volume of data. With the increasing number of
collected data and the availability of new technology, a new software
application has been developed. This application performs automatic data
validation and semi-automatic quality checks at a level suitable to the
majority of data users.

QC SOFTWARE
The new AODC software “Marine QC Ver.1.1”, is designed to improve the
QC processing of many marine data types. The system is seen to have a
distinct advantage from similar applications developed in the past, due to the
design being based around the ability to work with Extensible Markup
Language (XML) formatted data sets. This gives rise to a structure that will
expand to handle the large variety of data types that are of interest to the
marine scientific and defence communities.
The Marine QC software has a common interface (for all data types) for the
QC of spatial and temporal information of an observation. With the use of
various algorithms and a simplified GIS interface, the user is assisted in
correcting or discarding any errors identified in the data by the software.
The application also consists of a number of QC Modules tailored to handle
the quality control of each individual data type. These modules are data type
specific and allow inspection, editing and flagging of the data. This software
has been designed to be versatile enough to allow for the development and
inclusion of new QC Modules for other data types as required. Currently three
Version 1.1
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modules have been developed and feature in the software to process RAN
collected data; delayed mode Mk12 XBT data, meteorological data and
seabed data.
Java is the language of choice for developing the software, which will provide
the application with the flexibility to operate under Windows, UNIX or MAC
systems.

QUALITY CONTROL PROCEDURE
This manual describes the quality control procedures for RAN collected data
at the AODC. This includes data validation, the quality assessment tests, data
quality flagging systems and individual Marine QC Modules. The Marine QC
application provides a number of quality control tests and a graphical
interface, combined with an interactive editor to correct and flag the data. All
processed and unprocessed data can be edited and flagged using the Marine
QC software. The original data values and QC history, together with quality
flags remain part of the final dataset’s XML file. One of the major advantages
of the Marine QC software is that data can be quality controlled in an
environment where all changes are preserved and appropriate flags assigned
in the Marine XML structure (See Appendix C for more information on
Marine XML).

MARINE QC MODULES
XBT QC MODULE

This module was developed to quality control the delayed mode eXpendable
BathyThermograph (XBT) data collected by the RAN. The module works on
XML formatted files with the “description” tag equal to “XBT”.
The module allows visualisation of individual profiles, together with
temperature/depth pairs, to check for and correct or flag any irregularities in
the profile. To assist the user, the module incorporates a number of visual aids
to assess each profile against such things as monthly and seasonal
climatology, regional bathymetry and neighbouring profiles.

METEOROLOGICAL
QC MODULE

This module was developed to quality control the ancillary meteorological
data acquired alongside XBT observations during RAN cruises. The module
works on XML formatted files with the “description” tag equal to
“MET_FROM_BATHY”.
The module offers visualisation of the data, along with interactive flagging
and editing capabilities. The module displays sea surface temperature, air
temperature, barometric pressure and wind data as functions of time.

SEABED QC MODULE

Version 1.1

This module was developed to quality control seabed composition data. The
module works on XML formatted files with the “description” tag equal to
“SEABED”. The module validates the seabed composition codes for
compatability with the International Hydrographic Organisation (IHO) seabed
codes “Chart 5011 (INT 1) IJ Nature of the Seabed”.
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ADDING ADDITIONAL
MARINE QC MODULES

Version 1.1

The Marine QC software has been developed in such away to allow the
incorporation of future QC modules for additional data types. These modules
will need to be developed in Java code for compatability. The procedure for
undergoing this process is not part of this manual. If you require further
information on adding additional QC modules please contact the AODC.
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CHAPTER 2 Functions Of MarineQC Software
ADDING A NEW USER
From the “Options” drop-down menu choose “Add New User”. A frame will
be brought up on screen (Figure 1) in which you will need to complete all of
the details before submission. Your new user details will be preserved upon
subsequent uses of Marine QC.

Figure 1 New User Details Form

SETTING THE DEFAULT OPENING DIRECTORY
From the “Options” drop-down menu choose “Set Default Directory”. You
then will be able to browse for a default opening directory of your choice.
This is useful if you have a large number of files to process in the same file
area.

GETTING HELP
Help is available in a searchable index form for MarineQC and each of its
Modules. To access the on-line help, from the “Help” drop-down list select
“Index”.

VIEWING XML FILES
To view the current XML file loaded in Marine QC choose “View XML” from
the “Tools” drop-down menu. This tool is very useful in comparing QC
results with the data in the XML file.

Version 1.1
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CHAPTER 3

QC Of Temporal & Spatial Data

INTRODUCTION
When the XML tagged file has been loaded, a summary of the loaded data set
is generated (Figure 2). The user can then check if all observations have been
completely loaded.

Figure 2 Cruise Summary Report

DATA QUALITY TESTS
The first phase of all quality control procedures is an automatic scan of the
dataset to pick up any abnormalities with the spatial and temporal information
for each data record (Figure 3). Any errors detected are highlighted by the
software and corrected by the user if possible.
The following quality assessment tests are run as listed below:

Version 1.1

1. Duplicate Check

4. Speed Check

2. Repeat Observation Check

5. Land Check

3. Range Check

6. Additional test (currently empty)
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Figure 3 Spatial & Temporal Data Display Table

The following data quality test results are provided for each observation as
follows:
?

Doubtful

*

Failed Test

-

Not Used

Blank Field

Passed Test

The original position of the observations are viewed in the form of a cruise
track plot as shown in Figure 4. This is done to assist the user in verifying that
the ship track is reasonable and as planned. An automatic routine verifies the
position, date, time and speed of the ship along the cruise track.

Figure 4 Cruise Track Plot
DUPLICATE CHECK

Version 1.1

The duplicate function checks if there are any duplicate observations within
the cruise. This may occur when the data file is originally compiled and an
observation is erroneously duplicated. The program looks for identical date,
time, latitude and longitude. If more than one copy of the original observation
is identified, only one copy of an observation needs to be preserved and any
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additional copies of the record should be rejected.
REPEAT OBSERVATION
CHECK

The repeat observation function identifies near-duplicate observations within
the cruise. This check is mostly only relevant to the processing of XBT data.
A repeat drop is defined when an XBT is deployed within 15 minutes (or 10
km) of another drop. This is usually due to suspected previous probe
deployment malfunction or to confirm an unusual feature. After close
examination of both profiles only erroneous observations need to be
discarded.

RANGE CHECK

This test performs a number of checks to ensure that date, time and position
values are within the valid range. Any missing or out of range values are
identified in a test result information table (Figure 3) and corrected if possible
or rejected if corrections cannot be made.

SPEED CHECK

The speed test checks that the calculated average speed between two
consecutive observations is within a ship speed limit. If the speed exceeds a
maximum ship speed for a particular ship type, both observation positions
(previous and current) are considered doubtful and are flagged as “failed
speed check”. Usually only one position is incorrect and if possible is
corrected. If it cannot be corrected with confidence the whole observation
needs to be rejected. It is possible that both observations may need to be
rejected if it cannot be determined that either is correct.

LAND CHECK

This test checks if any observation is located on land. Each observation
latitude and longitude values are compared with 5-minute grided bathymetry.
If the observation fails this test, it’s position can either be corrected, or if it can
not be corrected with a reasonably high degree of confidence the record needs
to be rejected.

EDITING SPATIAL & TEMPORAL DATA
QUALITY
ASSESSMENT

Each record is assessed in respect to the validity of the date, time and position.
Automated checks verify that the ship has traveled at a valid speed between 0
and 30 knots. Any observations with the speed level between 20 and 30 knots
are doubtful (?) and require manual inspection. All observations with
identified ship speeds above 30 knots are marked as failed speed check (*) and
require manual inspection. Cruise track plot and land check identify any
positions on land. The GIS interface is updated and the QC tests are re-run
when attempting to correct any positions. All observations that fail any of the
automatic tests and cannot be manually corrected will have a failed test results
tag stored within the XML file.

ERRORS

Spatial and temporal information for each record is displayed as a table
(Figure 3). To find out more details about why a particular record failed a
quality control test you can double click in the cell containing the error. You
may choose to ignore the error (which means that the error will not be
preserved in the XML file) or click OK which will preserve the error. You
then should try to fix the data to eliminate the error, or if this is not possible,
then reject the entire record.

CORRECTING DATA

Version 1.1

There are two methods to correct any of the spatial or temporal information:
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i)

Make sure you have selected the record in the table you wish to
edit. Click on the edit button to bring up an edit frame (Figure 5).

ii)

Double click inside a cell containing any of the spatial or temporal
information to bring up an edit frame.

Correct the data:
i)

Change a data value by overwriting the existing value in the data
field.

ii)

Hit the apply button. You must enter a valid reason for editing the
data. The quality control tests will be re-run.

iii)

Have a look at the data table to see if your change has removed the
bad test result from the record in question.

iv)

If your edit has fixed the problem hit OK.

v)

If your edit has not fixed the problem you may wish to reject the
entire record or reset the value to the previous one.

vi)

The cruise track will be updated. Upon saving these changes will be
stored in the updated XML file.

Figure 5 Observation Header Edit Window
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CHAPTER 4

Delayed Mode XBT QC Module

QUALITY CONTROL
RAN ships use the Sippican MK12 XBT recorder which is prone to a number
of system and operator malfunctions, in particular from the probe and
launcher, which generate erroneous temperature data. Some of these
malfunctions produce temperature errors that can be mistaken for real features
such as temperature inversions or fronts. QC operators need to be aware of
natural features within the region. For more information on horizontal and
vertical temperature variations see “Appendix B, Thermal Structure of the
Oceans”. Erroneous data can be restricted to a spike in a single recorded
temperature-depth value, or may effect temperature over a range of depths.
Many of the profiles can be “cleaned up” by removing these faulty data points
and downgrading the quality to Class 2 (see page 14 for “Data Quality
Classes”) from the depth of editing. Profiles with erroneous data points which
can not be edited are rejected from that depth.
For detail description and examples of XBT faults refer to the AODC
publication “Guide to MK12-XBT System (Including Launching, Returns and
Faults)” June 1999.
This version of the XBT QC Module does not perform any automatic quality
checks on profile data. Every profile needs to be visually inspected, flagged
and saved. The intention of the individual profile inspection is to identify and
flag erroneous data within the profiles and erroneous profiles within the
cruise. The individual profile window (Figure 6) displays cruise ID number,
file name, latitude, longitude, probe type, depth - temperature pairs, ancillary
data (SST, maximum depth), and GEBCO bathymetry.

Version 1.1
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Figure 6 Individual Profile

VALIDATION, EDITING & FLAGGING
PROFILE DATA

The raw depth - temperature data values can be viewed and while each pair is
selected, a horizontal arrow pointer on the profile plot graphically indicate the
position of this values. Depth - temperature values are blank if the data point
is rejected by applying a reject (DPR) flag.

PROFILE PLOT

The individual profile plots are inspected for common malfunctions, faulty
records and profile to profile consistency. Unusual features are cross validated
by comparison with repeat (15 minutes or 10 km apart) or neighbouring
profiles (within 100 km of another drop), and against long term statistical data
(World Oceans Atlas 1998).

PROFILE EDIT

The profile data can be edited to remove minor recording errors and to flag
any system malfunction. Depending on the severity of the problem the data
quality may be downgraded. The XBT data are classed 0 - 4 according to the
type of quality control flag associated with the data. The grading system is
outlined on page 14. All modifications that are made to the data are reflected
in coded quality flags. Anomalous features present within the profile data are
flagged to indicate whether it is a possible or definite XBT system error. Data
quality flags and codes used in the AODC QC process are described in the
“Profile Feature Flags” section on page 15. Results of the profile QC process
are recorded and stored in association with each depth - temperature pair in
the XML file. Removing erroneous values should be kept to minimum,

Version 1.1
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however it is always possible to recover the original data values if subsequent
users do not accept the editing procedures applied.
BUDDY PROFILES

The buddy function allows the user to select and overlay other profiles within
the cruise to confirm unusual features (Figure 7). It is possible to select any
neighbouring profile to be displayed. These profiles can be offset by a number
of degrees Celsius, and displayed in a different colour. Each buddy can also
be labelled with or without temperature offsets.

Figure 7 Buddy Profile
CLIMATOLOGY

This allows the user to backdrop climatological data to verify the observed
profile lies within the expected range (Figure 8).
Monthly, seasonal and annual climatology can be selected for 1, 2 or 3
standard deviation for a one degree square in which the observation lies.

Version 1.1
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.

Figure 8 Climatology

MAXIMUM DEPTH
CONTROL

The consistency between the maximum depth of the profile and the
corresponding General Bathymetric Chart of the Oceans (GEBCO97) value is
also checked. This is achieved by displaying a bathymetry profile on the plot
as well.

Figure 9

Version 1.1
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CHANGING PLOT MODES

Version 1.1

January 2002

HORIZONTAL
SHIFT MODE

Allows you to drag the plot in the horizontal direction.

VERTICAL
SHIFT MODE

Allows you to drag the plot in the vertical direction.

DRAG MODE

Allows you to drag the plot in the any direction.

ZOOM MODE

Allows you to zoom in on a particular area by selecting a
region with the mouse.

RESET SCALE

Allows you to reset the scale as it was before zooming.

BUDDY MODE

Allows you to view buddy profiles, either before or after
the current profile.

CLIMATOLOGY
MODE

Allows you to view monthly, annual or seasonal
climatology band.

ADD FLAG

Allows you to insert a flag at any point in the profile.

GRID MODE

This toggle button allows you to turn the grid view on or
off.

BATHYMETRY
MODE

This toggle button allows you to turn the bathymetry
view on or off.

REMOVE FLAG
MODE

Allows you to remove any flag in the profile.

SORT MODE

Allows you to sort the dataset by filename.

MarineQC User Guide
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DATA QUALITY CLASSES - (XBT-Mk12-AODC1.0)
The data quality classes are used as flags to tag XBT data in the XML file.

Version 1.1

CLASS

QUALITY

Class 0

No QC
Done

Class 0 data is the xml
generated data that has not
yet been quality controlled.

Class 1

Good Data

Class 1 data is top quality
data where no system
malfunctions have been
identified

Class 2

Doubtful
Data

Class 2 data is good data
where minor malfunctions
may be present but these
errors are within an
acceptable range and do not
effect entire profile.
Data is downgraded to Class
2 from the depth of
anomalous features.

Class 3

Modified
Data

Class 3 data is probably good
data where some erroneous
features are observed but are
small and can be successfully
corrected without seriously
affecting the overall quality
of the data. Data is
downgraded to Class 3 from
the depth of erroneous
features.

Class 4

Bad Data

Class 4 data is bad data where
erroneous values are
observed. Data is
downgraded to Class 4 from
the depth of erroneous
features.

January 2002
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PROFILE FEATURE FLAGS
Each temperature profile needs to be visually inspected. If the entire profile is
correct, it needs to be ticked off in the inspection box. Profiles which
experience a definite system malfunction that renders the entire profile
invalid, requires the appropriate flag to be inserted at the surface level and the
inspection annotation box will be ticked off automatically at the time of
flagging. Similarly, where a malfunction or anomaly occurs at depth, the
appropriate flag should be added at that depth, which also automatically
renders the profile inspected.

Figure 10 Quality Control Flags

PROBE HIT BOTTOM HBR (CLASS 4)

Version 1.1

When an XBT is deployed in a water depth shallower than the probes rated
depth a “hit bottom” event is recorded. A small spike on the temperature trace
and isothermal looking profile (sometimes gradually increasing in
temperature) after the spike usually indicates the bottom hit. In some cases the
spike may be very small and difficult to discern. Bathymetry (DBDB5) data
and neighbouring profiles should be used to estimate bottom depth within the
area. Data recorded beyond the hit bottom point is rejected as erroneous.
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WIRE BREAK - WBR
(CLASS 4)

The XBT probe contains a temperature sensitive thermistor connected to thin
enamel coated two-conductor wire. The wire is very thin and will break with
less than 0.5 kg tension. Wire breakage is indicated by a sudden deflection to
the high or low temperature side. All recorded data beyond the initial point of
damage is erroneous and rejected.

WIRE STRETCH - WSA
(CLASS 2)

Increasing tension due to poor wire unreeling leads to wire stretch. This results
in a characteristic bulge (warming) to the high temperature side. If the
magnitude of the anomaly is small (~0.2o C) and over a small range of depth
that it does not seriously effect the overall quality of the data all data points
are downgraded to class 2 from the depth of possible wire stretch.

WIRE STRETCH - WSR
(CLASS 4)

Profiles where the wire stretch causes an increase of temperature with depth
more than 0.2o C over a large range of depths, the data recorded beyond the
stretch point are erroneous and rejected.

LEAKAGE - LEA
(CLASS 2)

Profiles with launcher leakage being recorded exhibit unusual looking
excursions to the high temperature side over a range of depths. LEA is used if
the anomaly is around 0.2o C over a small range of depths and is not seriously
effecting the overall quality of profile.

LEAKAGE - LER
(CLASS 4)

If launcher leakage feature exhibits unrealistic temperature increase of more
than 0.2o C over a range of depth or entire profile, the data must be rejected
from the initial leakage point.

FAULTY LAUNCHER
BREECH CONTACT FLBR (CLASS 4)

If the breech pin contact is lost just before bathy launch, low temperatures
usually less than 0o C is recorded. The trace may recover to record near real
temperature if the contact pin re-engages during launch. The profile must be
rejected from the surface.

FALSE LAUNCH
TRIGGERING -FLTR (CLASS 4)

Due to the electrical arrangement used in the XBT system it is possible for
XBT data recording to be initiated without the actual launching of the XBT
probe. Initially, after the false triggering the trace exhibits a temperature
similar to the sea surface temperature followed by low temperature, usually
below 0o C. Reject profile from the surface.

SPIKES - SPR (CLASS 4)

If the severe spikes (more than 0.2o C) appear over a wide range of depth
which can not be interpolated and the remaining temperature records are
considered unreliable the data must be rejected from the first erroneous point.

CONSTANT
TEMPERATURE
PROFILE-CTR(CLASS 4)

Usually a faulty probe produce near constant temperature record over entire
profile. If there is no confirmation of the sea surface temperature of an
isothermal profile on cross checking with neighbouring profiles such a trace
needs to be rejected.

INSULATION
PENETRATION - IPR
(CLASS 4)

Wire insulation penetration is indicated on the temperature recording by a
number of sharp spikes that run usually towards the high temperature side.
This is caused by wire damage. Also the temperature trace appears erratic
looking with increasing temperatures after the insulation damage point and
must rejected from that point.

Version 1.1
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TEMPERATURE
OFFSET -TOR(CLASS 4)

If an unrealistic temperature profile data is recorded over a large range of
depths which can not be confirmed with neighbouring profiles the entire
profile must be rejected.

TEST PROBE - TPR
(CLASS 4)

When
. a test probe is used for testing or calibration a characteristic isothermal
profile, usually 1.5o C is produced. TPR flag must be used from the surface
which rejects the entire profile.

NO TRACE - NTR
(CLASS 4)

This flag is used if no data has been recorded or if recorded data is totally off
scale.

NO GOOD PROFILE NGR (CLASS 4)

No good profile flag is used if part or the entire profile data is obviously
erroneous and none of the above flags can be used.

DATA POINT
REJECTION - DPR
(CLASS 3)

This flag is used to remove erroneous data points (spikes) associated with
external electrical or electromagnetic interference or wire insulation damage
faults.
The DPR flag is used in case of isolated or intermittent spikes bigger than
0.2oC. The erroneous data points can be removed if the spike is restricted to a
narrow range of depths (e.g. only few temperature records) and the remaining
temperature records are considered to be unaffected after interpolation. All
data below depth of spike become class 2.
The DPR flag is also used when the wire insulation penetration causes a sharp
spike towards the high or low temperature end of the scale, and quickly fully
recovers from it. When there is a consistency of temperature readings at depth
with neighbouring profiles the spikes can be removed and the remaining
profile data below depth of spike is downgraded to class 2.

DOUBTFUL PROFILE DPA (CLASS 2)

The doubtful profile flag (DPA) is used to flag each profile where the
maximum depth exceeds maximum bathymetric depth value by more than
30%.
This flag can also be use to flag any other profiles with a probable data
anomalies or system malfunction features which fall out of above described
flagging categories.

Version 1.1

January 2002

MarineQC User Guide

Produced by AODC

18

CHAPTER 5

Meteorological QC Module

INTRODUCTION
The Meteorological Quality Control Module was developed to visually check,
edit and flag observed meteorological data taken as ancillary data to XBT data
collected by the RAN.
Initially, all the meteorological data is converted from CSV into Marine XML
format using XML Generator. The data is range checked and correspondingly
flagged as it is passed to XML. The following flag system is used:
AODC Quality Control Flags Version 1.0
No Flag - Original value
1 - Corrected value
2 - Suspect value
3 - Erroneous value

Although the data has gone through initial quality control checks it is
impossible to truly check the data without visual inspection. Through visual
inspection the module allows data to be checked by comparison with
surrounding data points. Eventually, climatological data will also be
incorporated into the module as a tool for comparitive purposes. The module
displays the following parameters only, although other parameters are also
collected.
Sea Surface Temperature
Dry Bulb Temperature
Wet Bulb Temperature
Sea Level Pressure
Wind Direction
Wind Velocity

The meteorological quality control module (Figure 11) has facilities to
display and edit the data or change values of flags associated with the data.
There are several plotting modes which the module may operate in. The
configuration may be changed by selecting which parameters you wish to
view, along with the order in which they are plotted. Lines between
consecutive data points are plotted where the time difference between data
points is less than half a day.
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Figure 11 Meteorological QC Module Display

QUALITY CONTROL
The quality control of the meteorological data involves scanning through the
data looking for any data automatically flagged as suspect (orange flag) or
erroneous (red flag). It should then be determined whether it is possible to
change the value to make it within range by comparing it with the surrounding
data points. Data points with suspect or erroneous flags may also be edited to
have no flag if the data point is acceptable.
The second part of the quality control process involves looking for any
anomolous data that has no flag but is still unreasonable compared to the data
surrounding the data point in question. Either fix the value or change the flag
of this data point.
Module’s Acceptable Ranges
Sea Surface Temperature 0 to 40 degC
Dry Bulb Air Temperature -50 to 50 degC
Wet Bulb Air Temperature -50 to 50 degC
Sea Level Pressure 800 to 1100 hPa
Surface Wind Velocity 0 to 300 knots
Surface Wind Direction 0 to 360 degT
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A table of the acceptable ranges for each of the parameters visualised in the
Meteorlogical QC Module is displayed above. Please note that these are
extreme ranges. Data may still be erroneous even if it falls within the ranges
displayed.

CHANGING THE CONFIGURATION OF THE PLOTS
By clicking on the “Configuration” button you can change the configuration
of the plots. A frame will be brought up on screen (Figure 12) where changes
can be made.

Figure 12 Configuration Panel

By using the checkboxes available you can chose to plot the data in order of
record number or in order of time. For the temperature plot you may choose
to view all of the temperature data or just some. Click the SUBMIT button to
update the configuration or you may CANCEL.

DATA POINT SELECTION
There are several methods to select a particular data point:
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i)

In XY Select Mode you may click on the plot and the nearest data
point will be selected.

ii)

You may use the left and right arrows to move the selection bar one
data point to the left or right.

iii)

You may enter a particular record ID into the record field and that
record will be selected.

iv)

You may select a record on the LHS QC Panel and that record will
be selected on the RHS. (Be careful this does not work the other
way around).
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CHANGING PLOT MODES
By clicking on any of the following icons you are changing the mode of the
plot.

XY SELECT
MODE

Allows you to select a data point using the mouse.

HORIZONTAL
SHIFT MODE

Allows you to drag the plot in the horizontal direction.

VERTICAL
SHIFT MODE

Allows you to drag the plot in the vertical direction.

ZOOM MODE

Allows you to zoom in on a particular area by selecting a
region with the mouse.

RESET SCALE

Allows you to reset the scale as it was before zooming.

PLOT
INCLUDING
ERRONEOUS

Plots all of the data, inclusing data points flagged as
erroneous.

PLOT
EXCLUDING
ERRONEOUS

Plots all of the data, except for those data with erronous
flags. Please note that the flagged erroneous data are still
part of the data set.

EDITING DATA
The following edits section of the Meteorological Quality Control Module are
where all changes to the data should be made (Figure 13).

Figure 13 Meteorological Edit Table
TO CHANGE A DATA
VALUE:
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You may type directly over the top of data in any of the data fields. Changes
will not be preserved immediately. Upon hitting the enter button in the field
the data will be range checked and an edit frame will appear (Figs 14 & 15).
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Figure 14 Meteorological Edit Details Frame

Figure 15 Meteorological Outside Range Edit Details Frame

The frame illustrated in Figure 14 is brought up if the data being edited passes
range checks. The frame in Figure 15 is brought up if the data is outside of
the accepted ranges.You must complete the fields for Reason For Edit and
Edit Performed By in both cases before hitting either the SUBMIT button or
the Include Outside Of Range Value button.
TO CHANGE A DATA
FLAG:

Using the coloured buttons illustrated below you may change the flag
associated with a particular data point.
To change a flag, click on the flag button you require, then click within the
data field that you need to change the flag in.
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TO RESTORE DATA TO
ITS ORIGINAL VALUE:

Version 1.1

Colour

Flag Descriptor

Flag ID

Red

Erroneous

3

Orange

Suspect

2

Green

Corrected

1

White

No Flag

0

By clicking on the Restore Original Data button then clicking within a data
field that has been edited (should be green, i.e. corrected) it will remove the
edit from the data and restore the data back to its original value.
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CHAPTER 6

Seabed QC Module

INTRODUCTION
The Seabed QC Module was developed to visually inspect the seabed sample
composition data collected by the RAN Hydrographic survey ships and to edit
and flag it appropriately. Figure 16 shows the main display of the module.

Figure 16 Seabed QC Module Display

Initially, all the seabed data is converted from CSV into Marine XML format
using XML Generator. The data is range checked and correspondingly
flagged as it is passed to XML. The following flag system is used:
AODC Quality Control Flags Version 1.0
No Flag - Original value
1 - Corrected value
2 - Suspect value
3 - Erroneous value
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Although the data has gone through initial quality control checks it is
impossible to truly check the data without visual inspection. Through visual
inspection the module allows data to be checked by comparison with
surrounding data points.

QUALITY CONTROL
The seabed composition codes are flagged if they are erroneous when they are
converted to XML format using the XML Generator. The Seabed QC Module
displays all the composition data in a table for the whole dataset. Three
columns in green (corrected), orange (suspect) and red (erroneous) make up
part of the table. Flags associated with a record are indicated by the presence
of a (*) in one of the green, orange or red columns.
Quality control of the dataset is achieved by scrolling through the table and
assessing whether there are any suspect or erroneous seabed codes that may
be modified by comparison with surrounding codes.
The format of the seabed composition code must obey the following rules:
1. All codes must be seperated by (.)
2. The descriptor code must precede the material code.
3. There can be more than one descriptor for a material or no descriptor.
4. The descriptors “f”, “m” and “c” can be used to describe Sand only.
Scrollable lists of the allowed seabed descriptor and material codes make up
part of the Seabed QC Module display.

EDITING DATA
CHANGING A DATA
VALUE

To change a data value you just double click on the relevant seabed
composition cell within the table. An edit frame is brought up on screen
(Figure 17).

Figure 17 Seabed Composition Edit Frame
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Once you complete all the details required in this frame and hit the SUBMIT
button the new value entered is checked for validity. If it passes the validity
test the field is updated. If it fails, you are asked to edit it again or cancel the
edit.
CHANGING A FLAG

To change a data flag all you need do is to double click in the relevant flag cell
and a pop-up menu appear asking if you would like to add or remove a flag.

RESTORING DATA TO
ORIGINAL VALUE

To restore data to its original value, just double click on the relevant seabed
composition cell within the table. If the data has been modified in any way
then the “Restore Original Data” button will be active. Hit the button and the
display and dataset will be updated with the original value.
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APPENDIX A
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APPENDIX B

ThermalStructureOf
TheOceans

HORIZONTAL
TEMPERATURE
STRUCTURE

Ocean temperatures near the surface are strongly influenced by the regional
currents. Currents transport warm and cold water throughout the world’s
oceans. The circulation of the ocean’s surface waters is primarily wind driven.
Relative high horizontal gradients at the surface are indicative of significant
variations in oceanographic conditions. Some coastal regions of the world’s
oceans are affected by freshwater runoff from continents via major river
systems. Distinct temperature patterns also occur in regions of upwelling. The
sea-surface temperatures (SST) in these regions are colder than the water
surrounding such regions. Also, depending on the strength of the upwelling,
the sea-surface temperatures can be colder than what otherwise might be
expected. Another features of local SST characteristics are eddies. They form
independent clockwise and anti-clockwise circulations of cold or warm water.
The changes that take place in SST patterns can primarily be attributed to the
advection of cold or warm water brought about by the wind. Cross-current
wind causes warm or cold water advection, while wind that blows parallel to
ocean currents causes no advective change in the SST.

SEA SURFACE
TEMPERATURE

Ocean Sea Surface Temperatures (SST) vary from a low of -2oC in the high
latitudes to over 30oC in enclosed tropical waters. Deep and bottom water
temperatures are always low, ranging between 4˚C and 1˚C. The annual
variation of sea-surface temperature in any region is controlled by surface
heating or cooling, evaporation, precipitation, mechanical and convective
mixing. The annual range of surface temperature is much greater over the
oceans of the Northern Hemisphere than those of the Southern Hemisphere.
This wider range of temperatures is associated with the character of the
prevailing winds, particularly the cold winds blowing from the continents.
The annual range of ocean temperatures in the Southern Hemisphere is related
to the range of incoming solar radiation, as a result of the absence of large land
masses south of 45˚S. In the Southern Oceans the prevailing winds travel
almost entirely over water. This brings a far greater degree of consistency in
the annual sea-surface temperature patterns and a much smaller annual
temperature range compared to the Northern Hemisphere. Figure 18 shows a
satellite image (NOAA) of SST from NOAA satellite for the Australian
region.
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Figure 18 Sea Surface Temperature Around Australia

Australian Western and Eastern coastal waters are dominated by two major
oceanographic features, the Leeuwin Current and the East Australian Current
(Figure 19).

Figure 19 Sea Surface Temperature off Australian Western and Eastern coast.
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THE LEEUWIN
CURRENT

The Leeuwin Current is a surface stream of warm, low salinity, tropical water
that flows southward, against the climatological mean equator-ward wind,
from northwest Australia to Cape Leeuwin and then eastwards towards the
Great Australian Bight. The Leeuwin Current varies seasonally in both speed
and permanence. The current is faster in late autumn to winter (May to
August) than in summer (December to March). Off the coast of Fremantle the
current appears to be present all year round. During summer the mean wind
stress along much of the coast is strongly northwards which contributes to a
weakening of the Leeuwin Current at this time.
The Leeuwin current generates both warm and cold core eddies on its seaward
side. The eddies penetrate to a maximum depth of about 300m. Temperature
fronts occur at the edges of the Leeuwin current and eddies. Temperature
differences of up to 5˚ C can occur on passing from colder water to the
Leeuwin current core. Temperature changes of approximately 3˚C will occur
on crossing the eddies generated by the Leeuwin Current. The Leeuwin
current and associated eddies are usually located east of 110˚E and between
26˚S and 35˚S. There can be significant mixed layer depths from autumn to
early winter, when layer depths can be isothermal down to 150m depth near
the centre of the current. Layer depths of up to 100m occur near the centre of
Leeuwin current eddies.

EAST AUSTRALIAN
CURRENT

The East Australian Current (EAC) system flows southward along the east
coast of Australia, dominating the oceanographic conditions of the Western
Tasman Sea. It transports Coral Sea Water of relatively high temperature (20˚
C - 26˚ C) and low salinity (35.4 - 35.6 parts ppt) from the equatorial region
southward into the Tasman Sea. Characteristic of the EAC path are its
temporal and spatial variability. The current is present at all times of the year,
but is generally strongest between December and April. The width of the
current is about 150km at its maximum. The EAC extends south from about
18˚S at its northern extreme sometimes as far as 42˚ S near Bass Strait at its
southern extreme.
South of approximately 32˚S large warm-core eddies are the dominant feature
of the EAC system. Figure 20 shows the thermal structure indicated by the
temperature isotherms at 250m depth of a warm core eddies.

Figure 20 Sea water temperature at 250m depth
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The eddies range in size from 150-250 km in diameter. The EAC eddies
maintain their water mass identities for many months, and in some cases
years. Figure 21 shows a temperature profile taken from an observation inside
an EAC eddy. These eddies are usually well mixed down to a depth of around
400m and may affect the thermal structure down to 1300m depth.

Figure 21 Deep isothermal layer inside East Australian Current eddy

VERTICAL
TEMPERATURE
STRUCTURE

The basic vertical structure of the ocean is generally divided into three zones
(Figure 22):
1. The Surface Mixed Layer
2. The Main Thermocline
3. The Deep Water Layer
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Figure 22 Typical Thermal Structure of the Oceans

Vertical temperature gradients are computed from the temperatures and
depths reported in BathyThermograph (BT) observations. The vertical
temperature gradients show the change in temperature over a given vertical
distance.
The annual variation of temperature in sub-surface layers depends on several
factors: the variation in the amount of heat that is directly absorbed at different
depths, the effect of heat conduction, the variation in currents related to lateral
displacement, and the effect of vertical motion. Of these three main layers, the
mixed layer is the most variable in its properties, primarily depth.
Another layer of high variability and of great importance in anti submarine
warfare is the sonic layer. The sonic layer is a layer that basically traps sound
waves. The Sonic-Layer Depth (SLD) is the level of maximum sound velocity
based primarily on temperature, but also controlled by density and pressure.
The sonic-layer depth and the mixed-layer depth (MLD) often coincide
(Figure 22).
THE SURFACE MIXED
LAYER

The mixed layer is the upper layer of the three-layered ocean model. It is a
layer of fairly constant warm temperatures which, in middle latitudes, extends
from the surface to a maximum depth of about 450 meters.
The thermal structure of the surface mixed layer exhibits characteristic
seasonal and regional variability influenced by meteorological conditions, and
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the depth of the mixed layer varies accordingly. During the winter months the
sonic layer depth is influenced by strong winds, high seas and weak solar
radiation which results in a great amount of mixing, producing a deep
isothermal layer up to 400 m. During summer, the winds are usually lighter
and the mixed layer does not usually extend as deep. Spring and autumn are
transitional months when the thermal profiles are more complex. The mixed
layer occurs between 5-100 m in low latitudes and 25-250 m in mid latitudes.
Below the mixed layer, very little mixing occurs. The depth at which mixing
ceases to occur is marked by the Mixed Layer Depth (MLD).
THERMOCLINES

The main thermocline is the central layer of the ocean. It is found at the base
of the mixed layer and is marked by a rapid decrease of water temperature with
depth. A thermocline is a relatively shallow feature whose depth is directly
influenced by the extent of vertical mixing.

THE SEASONAL
THERMOCLINE

At high latitudes there is no marked change in water temperature with the
seasons, while in the mid-latitudes, a seasonal thermocline develops in the
summer time (Figure 23). This seasonal thermocline may develop in the
surface layer up to about 200 meters depth from the gradual warming of the
surface waters.
The warming takes place in the upper water level, and results in the seasonal
thermocline becoming super-imposed on the main thermocline. In low
latitudes, small seasonal temperature changes make it difficult to distinguish
between the seasonal and the permanent thermoclines.

TEMPERATURE
Degrees Celsius

SUMMER

DEPTH IN METERS

SPRING
AUTUMN

WINTER

Figure 23 Upper level thermal structure of seasonal thermocline in middle latitudes
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The structure of the seasonal thermocline will vary from year to year due to
variations in the strength and duration of wind and the amount of solar
radiation absorbed.
THE PERMANENT
THERMOCLINE

Beneath the surface layer is a region where temperature decreases rapidly with
depth.This is a transition zone between the warm surface layer and the cold
deep layer. Mixing and heat exchange takes place between the two layers in
this zone. It is a permanent feature at depths between 200-500m and 10001500m and is subject only to regional variations of depth and magnitude.

THE DEEP WATER
LAYER

The deep water layer is the bottom layer of water column in which
temperature decreases very slowly with depth. This layer is characterized by
fairly constant cold temperatures, generally less than 4˚C. At high latitudes in
winter, the water is cold from top to bottom. The vertical temperature profile
is essentially isothermal (no change in temperature with depth). Most types of
expendable BT probes are designed to measure the temperature versus depth
within the top 800 m of water column and they do not extend far into the deep
water zone.
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APPENDIX C

Marine XML DTD

This appendix outlines the proposed Marine XML Document Type
Definition (DTD). Some of the elements outlined below are new or have
changed compared to the XML format being used in the current version
of the MarineQC application. New or modified elements or attributes
are accompanied by a *.

The MarineDataSet element
<!ELEMENT MarineDataSet(QCDetails, property*,
MarineDataRecord+)>
<!ATTLIST MarineDataSet
Caveat(TopSecret | Secret | Restricted | Unclassified)
#REQUIRED
>
This element encases the whole of the dataset.
A MarineDataSet element consists of:
One QCDetails element (containing details of any qc tests etc.)
0 or more property elements (properties pertaining to the dataset)
1 or more MarineDataRecord elements (each record contains all the data for
one temporal and spatial observation)
Attribute Definitions
* Caveat
This attribute must be present in the element and has to have the value of either:
TopSecret
Secret
Restricted
Unclassified
Example
<MarineDataSet Caviat="TopSecret">
<QCDetails..................../>
<property......................./>
<MarineDataRecord....../>
</MarineDataRecord>

This element does not have to be present.
There can be any number of these elements.

The QCDetails element
<!ELEMENT QCDetails (QCProcess?) >
<!ATTLIST QCDetails
agency CDATA #REQUIRED
operator CDATA #REQUIRED
date CDATA #REQUIRED
tests CDATA #REQUIRED
status (Complete | Incomplete) #REQUIRED
>
The QCDetails element may or may not contain one QCProcess child element.
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This element contains details about quality control tests that have been undertaken on all the
records within this dataset.
Attribute definitions
All the following attributes are required.
agency
A reference to the institution that carried out the quality control tests on this dataset.
Usually an abbreviated version or acronym derived from the institutions name.
operator
The initials of the person who carried out the the quality control tests on this dataset.
date
The date and time that the quality control tests were undertaken on this dataset. This
is expressed as a ISO8601 date and time valid of the format mmm d, yyyy hh:mm:ss AM/PM
(eg Jun 4, 2001 4:20:20 PM)
tests
Reference to the quality control checks that were carried out on the dataset.
* status
Must have value either "Complete" or "Incomplete". When creating a dataset should
be set to "Incomplete". After passing through MarineQC should be set to "Complete".
Example
<QCDetails agency=”AODC” operator=”BR” date=”Jun 4, 2001 4:20:20 PM”
tests=”DuplicateCheck1.0” status=”Complete”>
<QCProcess.............../>
</QCDetails>

* The QCProcess element
<!ELEMENT QCProcess (Flags)>
<!ATTLIST QCProcess
name CDATA #REQUIRED
module CDATA #REQUIRED
>
The QCProcess element must contain one child element, Flags.
This element is used to contain information to define the quality control flags and the quality
control module used to process the data.
Attribute definitions
name
This defines the name of the QC Flags. ie: "AODC Quality Control Flags Version 1.0"
module
This defines the name of the QC Module used to quality control the data.
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Example
<QCProcess name="AODC Quality Control Flags Version1.0"
module="MetQCModule1.0">
<Flags......./>
</QCProcess>

* The Flags element
<!ELEMENT Flags (#PCDATA)>
The Flags element is used to contain the flags definition used by the QC Module.
Example
<Flags>Not Modified = 0; Corrected = 1; Suspect = 2; Erroneous = 3;</Flags>

The property element
<!ELEMENT property (#PCDATA)>
<!ATTLIST property
typeName CDATA #REQUIRED
>
The property element is used to set any property the user may wish. It has been put in to allow
flexibility within the Marine XML structure.
Attribute Definitions
typeName
This attribute is required. Used to identify the name of the property encased by the
property element.
Example
<property typeName="Project">Marine Monitoring Project</property>

The MarineDataRecord element
<!ELEMENT MarineDataRecord (description, sourceAgency,
property*, SpatialReference, TemporalReference, Source, QC,
Edits, AncillaryData, PrimaryData)>
<!ATTLIST MarineDataRecord
ID CDATA #REQUIRED
>
A MarineDataRecord structure consists of :
One description element (description of the data type)
One sourceAgency element (source agency details)
Zero or more property elements (property pertaining to an individual record)
One SpatialReference element (geo-spatial data)
One TemporalReference element (temporal data)
One Source element (source in terms of if it has been observed or not)
One QC element (pertaining to qc test results)
One Edits element (pertaining to any edits performed on data)
One AncillaryData element (containing data not taken primarily)
One PrimaryData element (containing the primary data)
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Attribute Definitions
ID
This attribute is required and identifies the number ID of the record.
Example
<MarineDataRecord ID="0">
<description............. ........ />
<sourceAgency................ />
<property.........................../>
<SpatialReference............../>
<TemporalReference........../>
<Source............................./>
<Edits.............................../>
<AncillaryData.................../>
<PrimaryData..................../>
</MarineDataRecord>

You can have none or more than one of this element.

The description element
<!ELEMENT description (#PCDATA)>
A simple description of the data described by the record.
Example
<description>XBT</description>

The sourceAgency element
<!ELEMENT sourceAgency (#PCDATA)>
A simple statement of who the source agency of the data is. ie: who acquired the data.
Example
<sourceAgency>RAN</sourceAgency>

The SpatialReference element
<!ELEMENT SpatialReference (GeoPoint | GeoBox | GeoLine |
GeoPolygon)>
A SpatialReference structure consists of one of the following elements:
GeoPoint
GeoBox
GeoLine
GeoPolygon
Contains a set of elements to describe the geographical coverage of the record. This is to
adhere to the Geography Markup Language (GML) 2.0 recommendation.
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Example
<SpatialReference>
<GeoPoint.........../>
</SpatialReference>

The GeoPoint element
<!ELEMENT GeoPoint (coordinates)>
A GeoPoint element contains one element coordinates.
The GeoPoint element is used to specify a single point in space.
Example
<GeoPoint>
<coordinates......./>
</GeoPoint>

* The GeoBox element
<!ELEMENT GeoBox (coordinates, coordinates)>
A GeoBox element contains two coordinates child elements.
The GeoBox element is used to specify a rectangle spatial region.
Example
<GeoBox>
<coordinates....../>
<coordinates....../>
</GeoBox>

* The GeoLine element
<!ELEMENT GeoLine (coordinates, coordinates, coordinates?)>
A GeoLine element must contain at least two and at most three coordinates child elements.
The GeoLine element is used to specify a linear spatial region.
Example
<GeoLine>
<coordinates....../>
<coordinates....../>
<coordinates....../>
</GeoLine>
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* The GeoPolygon element
<!ELEMENT GeoPolygon (outerBoundaryIs, innerBoundaryIs*)>
A GeoPolygon element must contain:
One outerBoundaryIs element
Any number of innerBoundaryIs elements
The GeoPolygon element is used to specify a region covered by a spatial polygon.
Example
<GeoPolygon>
<outerBoundaryIs......../>
<innerBoundaryIs........./>
<innerBoundaryIs........./>
<innerBoundaryIs........./>
</GeoPolygon>

Can contain any number of innerBoundaryIs elements.

* The outerBoundaryIs element
<!ELEMENT outerBoundaryIs (LinearRing)>
A outerBoundaryIs element must contain one LinearRing element.
Example
<outerBoundaryIs><LinearRing ........./></outerBoundaryIs>

* The innerBoundaryIs element
<!ELEMENT innerBoundaryIs (LinearRing)>
A innerBoundaryIs element must contain one LinearRing element.
Example
<innerBoundaryIs>
<LinearRing ......../>
</innerBoundaryIs>

* The LinearRing element
<!ELEMENT LinearRing (coordinates, coordinates, coordinates,
coordinates, coordinates*)>
The LinearRing element must contain at least 4 coordinates child elements, but it may have
more.
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Example
<LinearRing>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
</LinearRing>

There can be none or more than one of this element.

* The coordinates element
<!ELEMENT coordinates (X, Y)>
The coordinates element must contain:
One X element
One Y element
The coordinates element is used to specify a single point in space.
Example
<coordinates>
<X......./>
<Y......./>
</coordinates>

* The X element
<!ELEMENT X (#PCDATA)>
The X element must contain the x-coordinate of the point in space. In our case the longitude.
Example
<X>-36.51</X>

* The Y element
<!ELEMENT Y (#PCDATA)>
The Y element must contain the y-coordinate of the point in space. In our case the latitude.
Example
<Y>131.35</Y>

The TemporalReference element
<!ELEMENT TemporalReference (Instant | Period)>
The TemporalReference element must contain one of the child elements; Instant or Period.
This element is used to describe the temporal extent of the observations for the record.
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Example
<TemporalReference>
<Instant........./>
</TemporalReference>

or

<TemporalReference>
<Period............/>
</TemporalReference>

The Instant element
<!ELEMENT Instant EMPTY>
<!ATTLIST Instant
year CDATA #REQUIRED
month CDATA #REQUIRED
day CDATA #REQUIRED
hour CDATA #REQUIRED
min CDATA #REQUIRED
sec CDATA #REQUIRED
>
The Instant element must be empty.
The Instant element is used to specify a specific point in time in GMT.
Attribute Definitions
All attributes are required.
year
Four digit year of the observation.
month
Two digit month of the observation.
day
Two digit day of the observation.
hour
Two digit hour of the observation.
min
Two digit minute of the observation.
sec
Two digit second of the observation.
Example
<Instant year="2002" month="01" day="22" hour="12" min="57" sec="00"/>

* The Period element
<!ELEMENT Period (Start, End)>
The Period element must contain the following:
One Start element
One End element
Used to define the start and end of a period in time for which the observations were taken over
within the record.
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Example
<Period>
<Start......./>
<End......../>
</Period>

* The Start element
<!ELEMENT Start (Instant)>
The Start element must contain one child element, Instant.
Used to define the start of the period as an instant.
Example
<Start>
<Instant....../>
</Start>

* The End element
<!ELEMENT End (Instant)>
The End element must contain one child element, Instant.
Used to define the end of the period as an instant.
Example
<End>
<Instant........../>
</End>

The Source element
<!ELEMENT Source (MarinePlatform?, MarineAgency?, Sensor*)>
<!ATTLIST Source
isObservedData (true | false) #REQUIRED
sourceFileName CDATA #REQUIRED
>
The Source element must contain:
0 or 1 MarinePlatform element
0 or 1 MarineAgency element
0 or more Sensor elements
This element contains a number of attributes and potentially child elements to describe where
the data originated from. Where marine source is an abstract concept for describing the the
source of the data within this record. This can include details of instrumentation and the
platform for observed data or institution / citation details for data produced by a particular
organisation.
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Attribute definitions
isObservedData
Indicates whether the data is raw observed data (isObservedData = true) or is
processed data (isObservedData = false).
sourceFileName
Reference to the name of the file this data originated from before becoming a part
of the XML file (if applicable).
Example
<Source isObservedData="true" sourceFileName="T0_00001.RDF">
<MarinePlatform............/>
This element may or may not be present.
<MarineAgency............./>
This element may or may not be present.
<Sensor........................./> There may be 0 or more of this element.
</Source>

The MarinePlatform element
<!ELEMENT MarinePlatform EMPTY>
<!ATTLIST MarinePlatform
shipName CDATA #REQUIRED
callSign CDATA #REQUIRED
cruiseID CDATA #REQUIRED
>
The MarinePlatform element must be empty.
Contains details about a marine platform used to obtain observed marine data. This element
is used where data is acquired at sea.
Attribute definitions
All attributes are required.
shipName
Full name of the marine platform.
callSign
Call sign of the marine platform.
cruiseID
Reference identification for the cruise that this data was obtained on.
Example
<MarinePlatform shipName="MERMAID" callSign="VLRX" cruiseID="hi186mer" />

* The MarineAgency element
<!ELEMENT MarineAgency (property*)>
<!ATTLIST MarineAgency
Company CDATA #REQUIRED
Project CDATA #REQUIRED
Details CDATA #REQUIRED
>
This element is used to provide details of the source of the data not acquired at sea.
The MarineAgency element may contain 0 or more property child elements.
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Attribute definitions
All the attributes are required.
Company
This is the name of the company, business or organisation that observed the data.
Project
This is the project name.
Details
This can be any relevant details relating to the project the data was acquired under.
Example
<MarineAgency Company="AODC" Project="Marine Monitoring Project" Details="Seabed
Composition Component">
<property typeName="Project Officer">
Mr. Marine
There may be 0 or more property elements.
</property>
</MarineAgency>

The Sensor element
<!ELEMENT Sensor EMPTY>
<!ATTLIST Sensor
classification CDATA #REQUIRED
type CDATA #REQUIRED
model CDATA #REQUIRED
>
The Sensor element must be empty.
Contains information about the sensor used to obtain the data.
Attribute definitions
All the attributes are required.
classification
General classification of the type of sensor. Simple acronyms are recommended.
type
Any further details about the sensor.
model
Details to reference the sensor as a particular model.
Example
<Sensor classification="Sea Surface Temperature" type="Bucket Thermometer"
model="TS231" />

The QC element
<!ELEMENT QC (FailedQCTests*)>
<!ATTLIST QC
reject (false | true) #REQUIRED
details CDATA #REQUIRED
>
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The QC element must contain 0 or more FailedQCTests child elements.
Information describing the outcome for this record from the quality control tests that were
carried out on the entire dataset (described in the QCDetails element).
Attribute definitions
All attributes are required.
reject
Boolean value indicating whether record has been rejected entirely due to the
failure of fundamental quality control tests. This indicates that the record is either missing key
information or the key information provided is deemed to be erroneous to such an extent that
is cannot be salvaged and as a result casts the record as significantly unreliable.
details
If the reject attribute is set to true, then this text field is used to describe briefly the
reasons.
Example
<QC reject="false" details="" />
or
<QC reject="true" details="Warning on LandCheck1.0">
<FailedQCTests............./> Can have 0 or more FailedQCTests
</QC>

elements.

The FailedQCTests element
<!ELEMENT FailedQCTests (QCTestResult*)>
The FailedQCTests element must contain a sequence of 0 or more QCTestResult child
elements.
Example
<FailedQCTests>
<QCTestResult................./>
</FailedQCTests>

Can have 0 or more of the QCTestResult elements.

The QCTestResult element
<!ELEMENT QCTestResult EMPTY>
<!ATTLIST QCTestResult
test CDATA #REQUIRED
result (Fail | Warning | Pass) #REQUIRED
details CDATA #REQUIRED
>
The QCTestResult element must be EMPTY.
Attribute definitions
test
Reference to the QC test that created this result. (These QC tests are described in
the QCDetails element).
result
The result of the test is described by one of three outcomes (failed, warning or
passed) shown in this field.
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details
Free text describing the outcome of the test.
Example
<QCTestResult test="LandCheck1.0" result="Warning" details="It is possible that this
observation is based on land." />

The Edits element
<!ELEMENT Edits (EditedValue*)>
The Edits element consists of 0 or more EditedValue child elements.
This element is used to encase all the edits performed on observations within a
MarineDataRecord element.
Example
<Edits/>
or
<Edits>
<EditedValue................../>

You can have more than one EditedValue child element.

</Edits>

The EditedValue element
<!ELEMENT EditedValue EMPTY>
<!ATTLIST EditedValue
date CDATA #REQUIRED
editedBy CDATA #REQUIRED
object CDATA #REQUIRED
field CDATA #REQUIRED
originalValue CDATA #REQUIRED
reason CDATA #REQUIRED
>
The EditedValue element must be EMPTY.
Attribute definitions
All attributes are required.
date
This is the date the edit was performed.
editedBy
This is the ID of the person editing the data.
object
This is the type of data being edited. ie: XData, XDataDescriptive, etc.
field
This is the name of the parameter being edited. ie: Sea Surface Temperature
originalValue
This is the original value of the data before editing.
reason
This is a brief description of the reason the edit was performed.
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Example
<EditedValue date=”Nov 30, 2001 3:59:23 AM” editedBy=”AODC.br”
object=”SpatialReference.GeoPoint” field=”latitude” originalValue=”-19.045”
reason=”Warning on LandCheck1.0, Warning on RepeatObsCheck1.0, Failed
SpeedCheck1.0” />

The AncillaryData element
<!ELEMENT AncillaryData (DataObject+)>
<!ATTLIST AncillaryData
numOfObjects CDATA #REQUIRED
>
The AncillaryData element must have 1 or more DataObject child elements.
This element is used to contain all data that is not the primary data being collected.
Attribute definitions
numOfObjects
This is used to specify the number of data or consequently DataObject elements
contained under the AncillaryData element.
Example
<AncillaryData numOfObjects="2">
<DataObject............../>
<DataObject............../>
</AncillaryData>

The PrimaryData element
<!ELEMENT PrimaryData (DataObject+)>
<!ATTLIST PrimaryData
numOfObjects CDATA #REQUIRED
>
The PrimaryData element must have 1 or more DataObject child elements.
This element is used to contain all data that is the primary data being collected.
Attribute definitions
numOfObjects
This is used to specify the number of data or consequently DataObject elements
contained under the PrimaryData element.
Example
<PrimaryData numOfObjects="3">
<DataObject............/>
<DataObject............/>
<DataObject............/>
</PrimaryData>
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The DataObject element
<!ELEMENT DataObject (XData | XDataDescriptive | XYData |
XYDataList)>
<!ATTLIST DataObject
id CDATA #REQUIRED
qcProcess CDATA #IMPLIED
>
The DataObject element must contain one child element that is one of the following:
XData
XDataDescriptive
XYData
XYDataList
The DataObject element is used to encase individual DataObjects and to identify the index
number of the object and the qcprocess used on the individual data object.
Attribute definitions
id
This attribute is REQUIRED. It identifies the number ID of the DataObject
element within the AncillaryData or PrimaryData elements.
qcProcess
This attribute is the name of the QCProcess used to QC this particular DataObject. It
should be the same as the attribute "name" specified for the element QCProcess defined
earlier.
Example
<DataObject id="0" qcProcess="AODC Quality Control Flags Version 1.0">
<XData................/> This element can be either XData, XDataDescriptive, XYDataList, XYData.
</DataObject>

* The XData element
<!ELEMENT XData (Parameter, Units, Data)>
The XData element must contain the following child elements:
Parameter
Units
Data
The XData element is used to specify one data value (double precision).
Example
<XData>
<Parameter........../>
<Units................../>
<Data................../>
</XData>
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* The XDataDescriptive element
<!ELEMENT XDataDescriptive (Parameter, Units, Data)>
The XDataDescriptive element must contain the following child elements:
Parameter
Units
Data
The XDataDescriptive element is used to specify one data value (string). Example
<XDataDescriptive>
<Parameter.........../>
<Units.................../>
<Data.................../>
</XDataDescriptive>

* The XYData element
<!ELEMENT XYData (xParameter, xUnits, yParameter, yUnits,
Data)>
The XYData element must contain the following child elements:
xParameter
xUnits
yParameter
yUnits
Data
The XYData element is used to specify one data pair (x, y) (double precision).
Example
<XYData>
<xParamater.........../>
<xUnits.................../>
<yParameter.........../>
<yUnits.................../>
<Data...................../>
</XYData>

* The XYDataList element
<!ELEMENT XYDataList (xParameter, xUnits, yParameter, yUnits,
QCStatus, Data)>
The XYDataList element must contain the following child elements:
xParameter
xUnits
yParameter
yUnits
QCStatus
Data
The XYDataList element is used to specify a series of (x, y) data pairs (double precision).
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Example
<XYDataList>
<xParamater.........../>
<xUnits.................../>
<yParameter.........../>
<yUnits.................../>
<QCStatus............./>
<Data...................../>
</XYDataList>

* The Parameter element
<!ELEMENT Parameter (#PCDATA)>
The Parameter element encases the name of the parameter measured.
Example
<Parameter>Sea Surface Temperature</Parameter>

* The xParameter element
<!ELEMENT xParameter (#PCDATA)>
The xParameter element encases the name of the x - parameter measured of the (x, y)
observation.
Example
<xParameter>Water Depth</xParameter>

* The yParameter element
<!ELEMENT yParameter (#PCDATA)>
The yParameter element encases the name of the y - parameter measured of the (x, y)
observation.
Example
<yParameter>Water Temperature</yParameter>

* The Units element
<!ELEMENT Units (#PCDATA)>
The Units element encases the units the parameter was measured in.
Example
<Units>Degrees Celcius</Units>
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* The xUnits element
<!ELEMENT xUnits (#PCDATA)>
The xUnits element encases the units used to measure the x - parameter of the (x, y)
observation.
Example
<xUnits>Metres</xUnits>

* The yUnits element
<!ELEMENT yUnits (#PCDATA)>
The yUnits element encases the units the y - parameter of the (x, y) observation was measured
in.
Example
<yUnits>Degrees Celcius</yUnits>

* The QCStatus element
<!ELEMENT QCStatus (#PCDATA)>
The QCStatus element is used to indicate whether the quality control on the observation has
been completed. A value of "0", the QC of this observation is complete. A value of "1", then
the QC of this observation is incomplete.
Example
<QCStatus>0</QCStatus>

* The Data element
<!ELEMENT Data (Observation+)>
<!ATTLIST Data
flagged (true | false) #REQUIRED
listLength CDATA #IMPLIED
>
The Data element must contain 1 or more Observation child elements.
The Data element is used to encase a series of observations for a particular data object.
XData, XDataDescriptive and XYData will only have one observation element. XYDataList
will have more than one observation element.
Attribute definitions
flagged
This attribute is required. It must be set to TRUE or FALSE. It is set to TRUE if the
data value has been flagged.
listLength
This attribute is not required if there is only one observation. Where the number of
observations is greater than 1, the listLength should be set to the number of observations. This
is the case for data type XYDataList.
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Example
<Data flagged="false">
<Observation............../>
</Data>
or
<Data flagged="false" listLength="2">
<Observation.................../>
<Observation.................../>
</Data>

* The Observation element
<!ELEMENT Observation (xValue, yValue?, flagID?)>
<!ATTLIST Observation
ID CDATA #IMPLIED
>
The Observation element consists of
One xValue element
One yValue element may or may not exist
One flagID element may or may not exist
The Observation element is used to encase either a x-value or (x-value, y-value) pair, along
with a flag, if required.
Attribute definitions
ID
This attribute is not required. It is only used for data of type XYDataList. Where it is
used it just identifies the index number of the observation within the data object.
Example
<Observation>
<xValue......./>
</Observation>

or

<Observation>
<xValue......./>
<yValue......./>
<flagID......../>
</Observation>

or

<Observation>
<xValue......../>
<flagID........./>
</Observation>

* The xValue element
<!ELEMENT xValue (#PCDATA)>
If data type is XData or XDataDescriptive the xValue element encases the value of the data at
the specific point in space and time. If data type is XYDataList or XYData the xValue element
encases the x value from the (x, y) data pair.
Example
<xValue>150</xValue>
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* The yValue element
<!ELEMENT yValue (#PCDATA)>
This element is only used for XYData or XYDataList data types. It encases the y value from
the (x, y) data pair.
Example
<yValue>23.5</yValue>

* The flagID element
<!ELEMENT flagID (#PCDATA)>
This element is only used if you wish to assign a flag to the observation. Flags should be
defined in the Flags element.
Example
<flagID>2</flagID>
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APPENDIX D

Marine XML File

Please note that this XML file is in the existing Marine XML format used with the MarineQC software. It does not conform
to the Marine XML DTD supplied in this manual and will be upgraded in the future.
<xml version="2.0" ?>
- <MarineDataSet Caviat="Unclassified">
- <QCDetails agency="AODC" operator="PS" date="Jan 22, 2001 1:20:25"
tests="DuplicateCheck1.0,RepeatObsCheck1.0,RangeCheck1.0,SpeedCheck1.0,LandCheck1.0">
</QCDetails>
- <MarineDataRecord ID="0">
<description>Mk12XBT</description>
<property typeName="sourceAgency">RAN</property>
- <SpatialReference>
- <GeoPoint>
<coordinates>20.566667,-156.9</coordinates>
</GeoPoint>
</SpatialReference>
- <TemporalReference>
<Instant year="2000" month="6" day="23" hour="9" min="14" sec="22" />
</TemporalReference>
- <Source isObservedData="true" sourceFileName="T0_00001.RDF">
<MarinePlatform shipName="HMAS ARUNTA" callSign="VKMQ" cruiseID="00020AR" />
<Sensor classification="XBT" type="T-10" model ="Mk12"/>
</Source>
- <QC reject="false" details="">
<FailedQCTests />
</QC>
<Edits />
- <AncillaryData numOfObjects="2">
- <DataObject id="0">
- <XYData>
<property typeName="xParameter">watertemperature</property>
<property typeName="xUnits">degreescelcius</property>
<property typeName="yParameter">waterdepth</property>
<property typeName="yUnits">metres</property>
<Data flagged="false">25.2, 0.0</Data>
</XYData>
</DataObject>
- <DataObject id="1">
- <XData>
<property typeName="Parameter">bathymetry</property>
<property typeName="Units">metres</property>
<Data flagged="false">80.0</Data>
</XData>
</DataObject>
</AncillaryData>
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- <PrimaryData numOfObjects="1">
- <DataObject id="0">
- <XYDataList>
<property typeName="xParameter">watertemperature</property>
<property typeName="xUnits">degreescelcius</property>
<property typeName="yParameter">waterdepth</property>
<property typeName="yUnits">metres</property>
<property typeName="qcDef">XBT-Mk12-AODC1.0</property>
<property typeName="yUnits">metres</property>
<Data flagged="true" listLength="321">24.895,0.63,0 25.035,1.26,0 25.115,1.89,0 25.11,2.52,0
25.111,3.149,0 25.117,3.779,0 25.113,4.409,0 25.121,5.039,0 25.126,5.669,0 25.119,6.298,0 25.12,6.928,0 25.122,7.558,0
25.12,8.187,0 25.129,8.817,0 25.122,9.446,0 25.126,10.076,0 25.123,10.705,0 25.125,11.334,0 25.123,11.964,0
25.12,12.593,0 25.117,13.222,0 25.125,13.851,0 25.122,14.48,0 25.12,15.109,0 25.123,15.739,0 25.12,16.367,0
25.127,16.996,0 25.123,17.625,0 25.126,18.254,0 25.126,18.883,0 25.124,19.512,0 25.126,20.141,0 25.129,20.769,0
25.131,21.398,0 25.123,22.027,0 25.126,22.655,0 25.122,23.284,0 25.125,23.912,0 25.123,24.541,0 25.124,25.169,0
25.123,25.797,0 25.125,26.426,0 25.123,27.054,0 25.123,27.682,0 25.122,28.31,0 25.123,28.938,0 25.124,29.566,0
25.121,30.195,0 25.126,30.823,0 25.128,31.451,0 25.126,32.078,0 25.123,32.706,0 25.123,33.334,0 25.128,33.962,0
25.122,34.59,0 25.124,35.217,0 25.123,35.845,0 25.124,36.473,0 25.123,37.1,0 25.126,37.728,0 25.127,38.355,0
25.125,38.983,0 25.125,39.61,0 25.116,40.237,0 25.119,40.865,0 25.122,41.492,0 25.115,42.119,0 25.109,42.746,0
25.107,43.374,0 25.101,44.001,0 25.099,44.628,0 25.095,45.255,0 25.09,45.882,0 25.092,46.509,0 25.088,47.136,0
25.078,47.762,0 25.072,48.389,0 25.066,49.016,0 25.063,49.643,0 25.063,50.269,0 25.059,50.896,0 25.054,51.522,0
25.051,52.149,0 25.05,52.775,0 25.046,53.402,0 25.05,54.028,0 25.043,54.655,0 25.046,55.281,0 25.049,55.907,0
25.045,56.534,0 25.042,57.16,0 25.044,57.786,0 25.044,58.412,0 25.041,59.038,0 24.986,59.664,0 24.927,60.29,0
24.892,60.916,0 24.808,61.542,0 24.702,62.168,0 24.603,62.794,0 24.512,63.419,0 24.445,64.045,0 24.348,64.671,0
24.26,65.296,0 24.198,65.922,0 24.141,66.547,0 23.971,67.173,0 23.885,67.798,0 23.8,68.424,0 23.764,69.049,0
23.73,69.674,0 23.698,70.3,0 23.632,70.925,0 23.598,71.55,0 23.586,72.175,0 23.581,72.8,0 23.578,73.426,0
23.571,74.051,0 23.567,74.676,0 23.555,75.3,0 23.539,75.925,0 23.504,76.55,0 23.464,77.175,0 23.434,77.8,0
23.407,78.425,0 23.39,79.049,0 23.381,79.674,0 23.35,80.298,0 23.315,80.923,0 23.287,81.547,0 23.269,82.172,0
23.254,82.796,0 23.228,83.421,0 23.176,84.045,0 23.141,84.669,0 23.118,85.294,0 23.089,85.918,0 23.049,86.542,0
23.02,87.166,0 22.995,87.79,0 22.974,88.414,0 22.967,89.038,0 22.961,89.662,0 22.962,90.286,0 22.964,90.91,0
22.962,91.534,0 22.965,92.157,0 22.954,92.781,0 22.954,93.405,0 22.955,94.029,0 22.955,94.652,0 22.953,95.276,0
22.944,95.899,0 22.911,96.523,0 22.853,97.146,0 22.808,97.769,0 22.773,98.393,0 22.739,99.016,0 22.717,99.639,0
22.7,100.263,0 22.691,100.886,0 22.686,101.509,0 22.662,102.132,0 22.624,102.755,0 22.606,103.378,0 22.602,104.001,0
22.59,104.624,0 22.586,105.247,0 22.587,105.869,0 22.582,106.492,0 22.584,107.115,0 22.561,107.738,0 22.494,108.36,0
22.418,108.983,0 22.322,109.606,0 22.233,110.228,0 22.162,110.85,0 22.091,111.473,0 22.067,112.095,0
22.059,112.718,0 22.049,113.34,0 22.04,113.962,0 22.039,114.584,0 22.035,115.207,0 22.034,115.829,0 22.035,116.451,0
22.031,117.073,0 22.026,117.695,0 22.008,118.317,0 21.999,118.939,0 21.988,119.561,0 21.976,120.182,0
21.959,120.804,0 21.958,121.426,0 21.949,122.048,0 21.941,122.669,0 21.929,123.291,0 21.92,123.912,0
21.918,124.534,0 21.902,125.156,0 21.873,125.777,0 21.849,126.398,0 21.818,127.02,0 21.79,127.641,0 21.773,128.262,0
21.744,128.883,0 21.724,129.505,0 21.706,130.126,0 21.7,130.747,0 21.698,131.368,0 21.686,131.989,0 21.668,132.61,0
21.663,133.231,0 21.653,133.852,0 21.616,134.473,0 21.556,135.093,0 21.424,135.714,0 21.304,136.335,0
21.204,136.955,0 20.866,137.576,0 20.612,138.197,0 20.495,138.817,0 20.435,139.438,0 20.406,140.058,0
20.382,140.679,0 20.349,141.299,0 20.33,141.919,0 20.321,142.539,0 20.306,143.16,0 20.296,143.78,0 20.292,144.4,0
20.287,145.02,0 20.283,145.64,0 20.289,146.26,0 20.286,146.88,0 20.283,147.5,0 20.279,148.12,0 20.274,148.74,0
20.281,149.36,0 20.281,149.979,0 20.278,150.599,0 20.28,151.219,0 20.282,151.838,0 20.274,152.458,0 20.283,153.077,0
20.279,153.697,0 20.26,154.316,0 20.245,154.936,0 20.234,155.555,0 20.221,156.175,0 20.212,156.794,0
20.215,157.413,0 20.183,158.032,0 20.097,158.651,0 19.973,159.27,0 19.891,159.89,0 19.83,160.509,0 19.691,161.128,0
19.576,161.746,0 19.529,162.365,0 19.466,162.984,0 19.415,163.603,0 19.31,164.222,0 19.215,164.84,0 19.128,165.459,0
19.1,166.078,0 19.021,166.696,0 18.947,167.315,0 18.915,167.933,0 18.889,168.552,0 18.869,169.17,0 18.836,169.789,0
18.767,170.407,0 18.707,171.025,0 18.663,171.644,0 18.647,172.262,0 18.639,172.88,0 18.639,173.498,0
18.625,174.116,0 18.62,174.734,0 18.614,175.352,0 18.598,175.97,0 18.592,176.588,0 18.575,177.206,0 18.555,177.824,0
18.551,178.441,0 18.534,179.059,0 18.516,179.677,0 18.498,180.294,0 18.476,180.912,0 18.472,181.529,0
18.456,182.147,0 18.435,182.764,0 18.429,183.382,0 18.418,183.999,0 18.405,184.617,0 18.385,185.234,0
18.336,185.851,0 18.271,186.468,0 18.228,187.086,0 18.166,187.703,0 18.111,188.32,0 18.069,188.937,0 18.06,189.554,0
18.011,190.171,0 17.904,190.788,0 17.842,191.404,0 17.814,192.021,0 17.784,192.638,0 17.759,193.255,0
17.738,193.871,0 17.707,194.488,0 17.651,195.105,0 17.62,195.721,0 17.559,196.338,0 17.472,196.954,0
17.415,197.571,0 17.371,198.187,0 17.21,198.803,0 17.128,199.42,0 17.069,200.036,0</Data>
</XYDataList>
</DataObject>
</PrimaryData>
</MarineDataRecord>
</MarineDataSet>
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CHAPTER 1

Introduction

AODC RAN DATA MANAGEMENT
At the end of each ship cruise, Royal Australian Navy (RAN) collected data
is forwarded to the Australian Oceanographic Data Centre (AODC) for
quality control (QC) and addition to the Navy’s Maritime Environmental
Database (MEDB). The variety of data collected by the RAN include:
Temperature Profiles
Meteorological
Seabed Composition
Bioluminescence
Water Transparency
Sound Velocity

Over the last 10 years the AODC has been using a number of different quality
control procedures to process all of the above data types. All of them have
been very labour intensive due to the manual process of quality checks
involved and the large volume of data. With the increasing number of
collected data and the availability of new technology, a new software
application has been developed. This application performs automatic data
validation and semi-automatic quality checks at a level suitable to the
majority of data users.

QC SOFTWARE
The new AODC software “Marine QC Ver.1.1”, is designed to improve the
QC processing of many marine data types. The system is seen to have a
distinct advantage from similar applications developed in the past, due to the
design being based around the ability to work with Extensible Markup
Language (XML) formatted data sets. This gives rise to a structure that will
expand to handle the large variety of data types that are of interest to the
marine scientific and defence communities.
The Marine QC software has a common interface (for all data types) for the
QC of spatial and temporal information of an observation. With the use of
various algorithms and a simplified GIS interface, the user is assisted in
correcting or discarding any errors identified in the data by the software.
The application also consists of a number of QC Modules tailored to handle
the quality control of each individual data type. These modules are data type
specific and allow inspection, editing and flagging of the data. This software
has been designed to be versatile enough to allow for the development and
inclusion of new QC Modules for other data types as required. Currently three
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January 2002

MarineQC User Guide

Produced by AODC

2
modules have been developed and feature in the software to process RAN
collected data; delayed mode Mk12 XBT data, meteorological data and
seabed data.
Java is the language of choice for developing the software, which will provide
the application with the flexibility to operate under Windows, UNIX or MAC
systems.

QUALITY CONTROL PROCEDURE
This manual describes the quality control procedures for RAN collected data
at the AODC. This includes data validation, the quality assessment tests, data
quality flagging systems and individual Marine QC Modules. The Marine QC
application provides a number of quality control tests and a graphical
interface, combined with an interactive editor to correct and flag the data. All
processed and unprocessed data can be edited and flagged using the Marine
QC software. The original data values and QC history, together with quality
flags remain part of the final dataset’s XML file. One of the major advantages
of the Marine QC software is that data can be quality controlled in an
environment where all changes are preserved and appropriate flags assigned
in the Marine XML structure (See Appendix C for more information on
Marine XML).

MARINE QC MODULES
XBT QC MODULE

This module was developed to quality control the delayed mode eXpendable
BathyThermograph (XBT) data collected by the RAN. The module works on
XML formatted files with the “description” tag equal to “XBT”.
The module allows visualisation of individual profiles, together with
temperature/depth pairs, to check for and correct or flag any irregularities in
the profile. To assist the user, the module incorporates a number of visual aids
to assess each profile against such things as monthly and seasonal
climatology, regional bathymetry and neighbouring profiles.

METEOROLOGICAL
QC MODULE

This module was developed to quality control the ancillary meteorological
data acquired alongside XBT observations during RAN cruises. The module
works on XML formatted files with the “description” tag equal to
“MET_FROM_BATHY”.
The module offers visualisation of the data, along with interactive flagging
and editing capabilities. The module displays sea surface temperature, air
temperature, barometric pressure and wind data as functions of time.

SEABED QC MODULE

Version 1.1

This module was developed to quality control seabed composition data. The
module works on XML formatted files with the “description” tag equal to
“SEABED”. The module validates the seabed composition codes for
compatability with the International Hydrographic Organisation (IHO) seabed
codes “Chart 5011 (INT 1) IJ Nature of the Seabed”.
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ADDING ADDITIONAL
MARINE QC MODULES

Version 1.1

The Marine QC software has been developed in such away to allow the
incorporation of future QC modules for additional data types. These modules
will need to be developed in Java code for compatability. The procedure for
undergoing this process is not part of this manual. If you require further
information on adding additional QC modules please contact the AODC.
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CHAPTER 2 Functions Of MarineQC Software
ADDING A NEW USER
From the “Options” drop-down menu choose “Add New User”. A frame will
be brought up on screen (Figure 1) in which you will need to complete all of
the details before submission. Your new user details will be preserved upon
subsequent uses of Marine QC.

Figure 1 New User Details Form

SETTING THE DEFAULT OPENING DIRECTORY
From the “Options” drop-down menu choose “Set Default Directory”. You
then will be able to browse for a default opening directory of your choice.
This is useful if you have a large number of files to process in the same file
area.

GETTING HELP
Help is available in a searchable index form for MarineQC and each of its
Modules. To access the on-line help, from the “Help” drop-down list select
“Index”.

VIEWING XML FILES
To view the current XML file loaded in Marine QC choose “View XML” from
the “Tools” drop-down menu. This tool is very useful in comparing QC
results with the data in the XML file.

Version 1.1
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CHAPTER 3

QC Of Temporal & Spatial Data

INTRODUCTION
When the XML tagged file has been loaded, a summary of the loaded data set
is generated (Figure 2). The user can then check if all observations have been
completely loaded.

Figure 2 Cruise Summary Report

DATA QUALITY TESTS
The first phase of all quality control procedures is an automatic scan of the
dataset to pick up any abnormalities with the spatial and temporal information
for each data record (Figure 3). Any errors detected are highlighted by the
software and corrected by the user if possible.
The following quality assessment tests are run as listed below:

Version 1.1

1. Duplicate Check

4. Speed Check

2. Repeat Observation Check

5. Land Check

3. Range Check

6. Additional test (currently empty)

January 2002

MarineQC User Guide

Produced by AODC

6

Figure 3 Spatial & Temporal Data Display Table

The following data quality test results are provided for each observation as
follows:
?

Doubtful

*

Failed Test

-

Not Used

Blank Field

Passed Test

The original position of the observations are viewed in the form of a cruise
track plot as shown in Figure 4. This is done to assist the user in verifying that
the ship track is reasonable and as planned. An automatic routine verifies the
position, date, time and speed of the ship along the cruise track.

Figure 4 Cruise Track Plot
DUPLICATE CHECK

Version 1.1

The duplicate function checks if there are any duplicate observations within
the cruise. This may occur when the data file is originally compiled and an
observation is erroneously duplicated. The program looks for identical date,
time, latitude and longitude. If more than one copy of the original observation
is identified, only one copy of an observation needs to be preserved and any
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additional copies of the record should be rejected.
REPEAT OBSERVATION
CHECK

The repeat observation function identifies near-duplicate observations within
the cruise. This check is mostly only relevant to the processing of XBT data.
A repeat drop is defined when an XBT is deployed within 15 minutes (or 10
km) of another drop. This is usually due to suspected previous probe
deployment malfunction or to confirm an unusual feature. After close
examination of both profiles only erroneous observations need to be
discarded.

RANGE CHECK

This test performs a number of checks to ensure that date, time and position
values are within the valid range. Any missing or out of range values are
identified in a test result information table (Figure 3) and corrected if possible
or rejected if corrections cannot be made.

SPEED CHECK

The speed test checks that the calculated average speed between two
consecutive observations is within a ship speed limit. If the speed exceeds a
maximum ship speed for a particular ship type, both observation positions
(previous and current) are considered doubtful and are flagged as “failed
speed check”. Usually only one position is incorrect and if possible is
corrected. If it cannot be corrected with confidence the whole observation
needs to be rejected. It is possible that both observations may need to be
rejected if it cannot be determined that either is correct.

LAND CHECK

This test checks if any observation is located on land. Each observation
latitude and longitude values are compared with 5-minute grided bathymetry.
If the observation fails this test, it’s position can either be corrected, or if it can
not be corrected with a reasonably high degree of confidence the record needs
to be rejected.

EDITING SPATIAL & TEMPORAL DATA
QUALITY
ASSESSMENT

Each record is assessed in respect to the validity of the date, time and position.
Automated checks verify that the ship has traveled at a valid speed between 0
and 30 knots. Any observations with the speed level between 20 and 30 knots
are doubtful (?) and require manual inspection. All observations with
identified ship speeds above 30 knots are marked as failed speed check (*) and
require manual inspection. Cruise track plot and land check identify any
positions on land. The GIS interface is updated and the QC tests are re-run
when attempting to correct any positions. All observations that fail any of the
automatic tests and cannot be manually corrected will have a failed test results
tag stored within the XML file.

ERRORS

Spatial and temporal information for each record is displayed as a table
(Figure 3). To find out more details about why a particular record failed a
quality control test you can double click in the cell containing the error. You
may choose to ignore the error (which means that the error will not be
preserved in the XML file) or click OK which will preserve the error. You
then should try to fix the data to eliminate the error, or if this is not possible,
then reject the entire record.

CORRECTING DATA

Version 1.1

There are two methods to correct any of the spatial or temporal information:
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i)

Make sure you have selected the record in the table you wish to
edit. Click on the edit button to bring up an edit frame (Figure 5).

ii)

Double click inside a cell containing any of the spatial or temporal
information to bring up an edit frame.

Correct the data:
i)

Change a data value by overwriting the existing value in the data
field.

ii)

Hit the apply button. You must enter a valid reason for editing the
data. The quality control tests will be re-run.

iii)

Have a look at the data table to see if your change has removed the
bad test result from the record in question.

iv)

If your edit has fixed the problem hit OK.

v)

If your edit has not fixed the problem you may wish to reject the
entire record or reset the value to the previous one.

vi)

The cruise track will be updated. Upon saving these changes will be
stored in the updated XML file.

Figure 5 Observation Header Edit Window
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CHAPTER 4

Delayed Mode XBT QC Module

QUALITY CONTROL
RAN ships use the Sippican MK12 XBT recorder which is prone to a number
of system and operator malfunctions, in particular from the probe and
launcher, which generate erroneous temperature data. Some of these
malfunctions produce temperature errors that can be mistaken for real features
such as temperature inversions or fronts. QC operators need to be aware of
natural features within the region. For more information on horizontal and
vertical temperature variations see “Appendix B, Thermal Structure of the
Oceans”. Erroneous data can be restricted to a spike in a single recorded
temperature-depth value, or may effect temperature over a range of depths.
Many of the profiles can be “cleaned up” by removing these faulty data points
and downgrading the quality to Class 2 (see page 14 for “Data Quality
Classes”) from the depth of editing. Profiles with erroneous data points which
can not be edited are rejected from that depth.
For detail description and examples of XBT faults refer to the AODC
publication “Guide to MK12-XBT System (Including Launching, Returns and
Faults)” June 1999.
This version of the XBT QC Module does not perform any automatic quality
checks on profile data. Every profile needs to be visually inspected, flagged
and saved. The intention of the individual profile inspection is to identify and
flag erroneous data within the profiles and erroneous profiles within the
cruise. The individual profile window (Figure 6) displays cruise ID number,
file name, latitude, longitude, probe type, depth - temperature pairs, ancillary
data (SST, maximum depth), and GEBCO bathymetry.
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Figure 6 Individual Profile

VALIDATION, EDITING & FLAGGING
PROFILE DATA

The raw depth - temperature data values can be viewed and while each pair is
selected, a horizontal arrow pointer on the profile plot graphically indicate the
position of this values. Depth - temperature values are blank if the data point
is rejected by applying a reject (DPR) flag.

PROFILE PLOT

The individual profile plots are inspected for common malfunctions, faulty
records and profile to profile consistency. Unusual features are cross validated
by comparison with repeat (15 minutes or 10 km apart) or neighbouring
profiles (within 100 km of another drop), and against long term statistical data
(World Oceans Atlas 1998).

PROFILE EDIT

The profile data can be edited to remove minor recording errors and to flag
any system malfunction. Depending on the severity of the problem the data
quality may be downgraded. The XBT data are classed 0 - 4 according to the
type of quality control flag associated with the data. The grading system is
outlined on page 14. All modifications that are made to the data are reflected
in coded quality flags. Anomalous features present within the profile data are
flagged to indicate whether it is a possible or definite XBT system error. Data
quality flags and codes used in the AODC QC process are described in the
“Profile Feature Flags” section on page 15. Results of the profile QC process
are recorded and stored in association with each depth - temperature pair in
the XML file. Removing erroneous values should be kept to minimum,
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however it is always possible to recover the original data values if subsequent
users do not accept the editing procedures applied.
BUDDY PROFILES

The buddy function allows the user to select and overlay other profiles within
the cruise to confirm unusual features (Figure 7). It is possible to select any
neighbouring profile to be displayed. These profiles can be offset by a number
of degrees Celsius, and displayed in a different colour. Each buddy can also
be labelled with or without temperature offsets.

Figure 7 Buddy Profile
CLIMATOLOGY

This allows the user to backdrop climatological data to verify the observed
profile lies within the expected range (Figure 8).
Monthly, seasonal and annual climatology can be selected for 1, 2 or 3
standard deviation for a one degree square in which the observation lies.
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.

Figure 8 Climatology

MAXIMUM DEPTH
CONTROL

The consistency between the maximum depth of the profile and the
corresponding General Bathymetric Chart of the Oceans (GEBCO97) value is
also checked. This is achieved by displaying a bathymetry profile on the plot
as well.

Figure 9
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CHANGING PLOT MODES

Version 1.1

January 2002

HORIZONTAL
SHIFT MODE

Allows you to drag the plot in the horizontal direction.

VERTICAL
SHIFT MODE

Allows you to drag the plot in the vertical direction.

DRAG MODE

Allows you to drag the plot in the any direction.

ZOOM MODE

Allows you to zoom in on a particular area by selecting a
region with the mouse.

RESET SCALE

Allows you to reset the scale as it was before zooming.

BUDDY MODE

Allows you to view buddy profiles, either before or after
the current profile.

CLIMATOLOGY
MODE

Allows you to view monthly, annual or seasonal
climatology band.

ADD FLAG

Allows you to insert a flag at any point in the profile.

GRID MODE

This toggle button allows you to turn the grid view on or
off.

BATHYMETRY
MODE

This toggle button allows you to turn the bathymetry
view on or off.

REMOVE FLAG
MODE

Allows you to remove any flag in the profile.

SORT MODE

Allows you to sort the dataset by filename.

MarineQC User Guide
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DATA QUALITY CLASSES - (XBT-Mk12-AODC1.0)
The data quality classes are used as flags to tag XBT data in the XML file.

Version 1.1

CLASS

QUALITY

Class 0

No QC
Done

Class 0 data is the xml
generated data that has not
yet been quality controlled.

Class 1

Good Data

Class 1 data is top quality
data where no system
malfunctions have been
identified

Class 2

Doubtful
Data

Class 2 data is good data
where minor malfunctions
may be present but these
errors are within an
acceptable range and do not
effect entire profile.
Data is downgraded to Class
2 from the depth of
anomalous features.

Class 3

Modified
Data

Class 3 data is probably good
data where some erroneous
features are observed but are
small and can be successfully
corrected without seriously
affecting the overall quality
of the data. Data is
downgraded to Class 3 from
the depth of erroneous
features.

Class 4

Bad Data

Class 4 data is bad data where
erroneous values are
observed. Data is
downgraded to Class 4 from
the depth of erroneous
features.

January 2002
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PROFILE FEATURE FLAGS
Each temperature profile needs to be visually inspected. If the entire profile is
correct, it needs to be ticked off in the inspection box. Profiles which
experience a definite system malfunction that renders the entire profile
invalid, requires the appropriate flag to be inserted at the surface level and the
inspection annotation box will be ticked off automatically at the time of
flagging. Similarly, where a malfunction or anomaly occurs at depth, the
appropriate flag should be added at that depth, which also automatically
renders the profile inspected.

Figure 10 Quality Control Flags

PROBE HIT BOTTOM HBR (CLASS 4)

Version 1.1

When an XBT is deployed in a water depth shallower than the probes rated
depth a “hit bottom” event is recorded. A small spike on the temperature trace
and isothermal looking profile (sometimes gradually increasing in
temperature) after the spike usually indicates the bottom hit. In some cases the
spike may be very small and difficult to discern. Bathymetry (DBDB5) data
and neighbouring profiles should be used to estimate bottom depth within the
area. Data recorded beyond the hit bottom point is rejected as erroneous.
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WIRE BREAK - WBR
(CLASS 4)

The XBT probe contains a temperature sensitive thermistor connected to thin
enamel coated two-conductor wire. The wire is very thin and will break with
less than 0.5 kg tension. Wire breakage is indicated by a sudden deflection to
the high or low temperature side. All recorded data beyond the initial point of
damage is erroneous and rejected.

WIRE STRETCH - WSA
(CLASS 2)

Increasing tension due to poor wire unreeling leads to wire stretch. This results
in a characteristic bulge (warming) to the high temperature side. If the
magnitude of the anomaly is small (~0.2o C) and over a small range of depth
that it does not seriously effect the overall quality of the data all data points
are downgraded to class 2 from the depth of possible wire stretch.

WIRE STRETCH - WSR
(CLASS 4)

Profiles where the wire stretch causes an increase of temperature with depth
more than 0.2o C over a large range of depths, the data recorded beyond the
stretch point are erroneous and rejected.

LEAKAGE - LEA
(CLASS 2)

Profiles with launcher leakage being recorded exhibit unusual looking
excursions to the high temperature side over a range of depths. LEA is used if
the anomaly is around 0.2o C over a small range of depths and is not seriously
effecting the overall quality of profile.

LEAKAGE - LER
(CLASS 4)

If launcher leakage feature exhibits unrealistic temperature increase of more
than 0.2o C over a range of depth or entire profile, the data must be rejected
from the initial leakage point.

FAULTY LAUNCHER
BREECH CONTACT FLBR (CLASS 4)

If the breech pin contact is lost just before bathy launch, low temperatures
usually less than 0o C is recorded. The trace may recover to record near real
temperature if the contact pin re-engages during launch. The profile must be
rejected from the surface.

FALSE LAUNCH
TRIGGERING -FLTR (CLASS 4)

Due to the electrical arrangement used in the XBT system it is possible for
XBT data recording to be initiated without the actual launching of the XBT
probe. Initially, after the false triggering the trace exhibits a temperature
similar to the sea surface temperature followed by low temperature, usually
below 0o C. Reject profile from the surface.

SPIKES - SPR (CLASS 4)

If the severe spikes (more than 0.2o C) appear over a wide range of depth
which can not be interpolated and the remaining temperature records are
considered unreliable the data must be rejected from the first erroneous point.

CONSTANT
TEMPERATURE
PROFILE-CTR(CLASS 4)

Usually a faulty probe produce near constant temperature record over entire
profile. If there is no confirmation of the sea surface temperature of an
isothermal profile on cross checking with neighbouring profiles such a trace
needs to be rejected.

INSULATION
PENETRATION - IPR
(CLASS 4)

Wire insulation penetration is indicated on the temperature recording by a
number of sharp spikes that run usually towards the high temperature side.
This is caused by wire damage. Also the temperature trace appears erratic
looking with increasing temperatures after the insulation damage point and
must rejected from that point.

Version 1.1
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TEMPERATURE
OFFSET -TOR(CLASS 4)

If an unrealistic temperature profile data is recorded over a large range of
depths which can not be confirmed with neighbouring profiles the entire
profile must be rejected.

TEST PROBE - TPR
(CLASS 4)

When
. a test probe is used for testing or calibration a characteristic isothermal
profile, usually 1.5o C is produced. TPR flag must be used from the surface
which rejects the entire profile.

NO TRACE - NTR
(CLASS 4)

This flag is used if no data has been recorded or if recorded data is totally off
scale.

NO GOOD PROFILE NGR (CLASS 4)

No good profile flag is used if part or the entire profile data is obviously
erroneous and none of the above flags can be used.

DATA POINT
REJECTION - DPR
(CLASS 3)

This flag is used to remove erroneous data points (spikes) associated with
external electrical or electromagnetic interference or wire insulation damage
faults.
The DPR flag is used in case of isolated or intermittent spikes bigger than
0.2oC. The erroneous data points can be removed if the spike is restricted to a
narrow range of depths (e.g. only few temperature records) and the remaining
temperature records are considered to be unaffected after interpolation. All
data below depth of spike become class 2.
The DPR flag is also used when the wire insulation penetration causes a sharp
spike towards the high or low temperature end of the scale, and quickly fully
recovers from it. When there is a consistency of temperature readings at depth
with neighbouring profiles the spikes can be removed and the remaining
profile data below depth of spike is downgraded to class 2.

DOUBTFUL PROFILE DPA (CLASS 2)

The doubtful profile flag (DPA) is used to flag each profile where the
maximum depth exceeds maximum bathymetric depth value by more than
30%.
This flag can also be use to flag any other profiles with a probable data
anomalies or system malfunction features which fall out of above described
flagging categories.
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CHAPTER 5

Meteorological QC Module

INTRODUCTION
The Meteorological Quality Control Module was developed to visually check,
edit and flag observed meteorological data taken as ancillary data to XBT data
collected by the RAN.
Initially, all the meteorological data is converted from CSV into Marine XML
format using XML Generator. The data is range checked and correspondingly
flagged as it is passed to XML. The following flag system is used:
AODC Quality Control Flags Version 1.0
No Flag - Original value
1 - Corrected value
2 - Suspect value
3 - Erroneous value

Although the data has gone through initial quality control checks it is
impossible to truly check the data without visual inspection. Through visual
inspection the module allows data to be checked by comparison with
surrounding data points. Eventually, climatological data will also be
incorporated into the module as a tool for comparitive purposes. The module
displays the following parameters only, although other parameters are also
collected.
Sea Surface Temperature
Dry Bulb Temperature
Wet Bulb Temperature
Sea Level Pressure
Wind Direction
Wind Velocity

The meteorological quality control module (Figure 11) has facilities to
display and edit the data or change values of flags associated with the data.
There are several plotting modes which the module may operate in. The
configuration may be changed by selecting which parameters you wish to
view, along with the order in which they are plotted. Lines between
consecutive data points are plotted where the time difference between data
points is less than half a day.
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Figure 11 Meteorological QC Module Display

QUALITY CONTROL
The quality control of the meteorological data involves scanning through the
data looking for any data automatically flagged as suspect (orange flag) or
erroneous (red flag). It should then be determined whether it is possible to
change the value to make it within range by comparing it with the surrounding
data points. Data points with suspect or erroneous flags may also be edited to
have no flag if the data point is acceptable.
The second part of the quality control process involves looking for any
anomolous data that has no flag but is still unreasonable compared to the data
surrounding the data point in question. Either fix the value or change the flag
of this data point.
Module’s Acceptable Ranges
Sea Surface Temperature 0 to 40 degC
Dry Bulb Air Temperature -50 to 50 degC
Wet Bulb Air Temperature -50 to 50 degC
Sea Level Pressure 800 to 1100 hPa
Surface Wind Velocity 0 to 300 knots
Surface Wind Direction 0 to 360 degT
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A table of the acceptable ranges for each of the parameters visualised in the
Meteorlogical QC Module is displayed above. Please note that these are
extreme ranges. Data may still be erroneous even if it falls within the ranges
displayed.

CHANGING THE CONFIGURATION OF THE PLOTS
By clicking on the “Configuration” button you can change the configuration
of the plots. A frame will be brought up on screen (Figure 12) where changes
can be made.

Figure 12 Configuration Panel

By using the checkboxes available you can chose to plot the data in order of
record number or in order of time. For the temperature plot you may choose
to view all of the temperature data or just some. Click the SUBMIT button to
update the configuration or you may CANCEL.

DATA POINT SELECTION
There are several methods to select a particular data point:
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i)

In XY Select Mode you may click on the plot and the nearest data
point will be selected.

ii)

You may use the left and right arrows to move the selection bar one
data point to the left or right.

iii)

You may enter a particular record ID into the record field and that
record will be selected.

iv)

You may select a record on the LHS QC Panel and that record will
be selected on the RHS. (Be careful this does not work the other
way around).
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CHANGING PLOT MODES
By clicking on any of the following icons you are changing the mode of the
plot.

XY SELECT
MODE

Allows you to select a data point using the mouse.

HORIZONTAL
SHIFT MODE

Allows you to drag the plot in the horizontal direction.

VERTICAL
SHIFT MODE

Allows you to drag the plot in the vertical direction.

ZOOM MODE

Allows you to zoom in on a particular area by selecting a
region with the mouse.

RESET SCALE

Allows you to reset the scale as it was before zooming.

PLOT
INCLUDING
ERRONEOUS

Plots all of the data, inclusing data points flagged as
erroneous.

PLOT
EXCLUDING
ERRONEOUS

Plots all of the data, except for those data with erronous
flags. Please note that the flagged erroneous data are still
part of the data set.

EDITING DATA
The following edits section of the Meteorological Quality Control Module are
where all changes to the data should be made (Figure 13).

Figure 13 Meteorological Edit Table
TO CHANGE A DATA
VALUE:
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You may type directly over the top of data in any of the data fields. Changes
will not be preserved immediately. Upon hitting the enter button in the field
the data will be range checked and an edit frame will appear (Figs 14 & 15).
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Figure 14 Meteorological Edit Details Frame

Figure 15 Meteorological Outside Range Edit Details Frame

The frame illustrated in Figure 14 is brought up if the data being edited passes
range checks. The frame in Figure 15 is brought up if the data is outside of
the accepted ranges.You must complete the fields for Reason For Edit and
Edit Performed By in both cases before hitting either the SUBMIT button or
the Include Outside Of Range Value button.
TO CHANGE A DATA
FLAG:

Using the coloured buttons illustrated below you may change the flag
associated with a particular data point.
To change a flag, click on the flag button you require, then click within the
data field that you need to change the flag in.
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TO RESTORE DATA TO
ITS ORIGINAL VALUE:

Version 1.1

Colour

Flag Descriptor

Flag ID

Red

Erroneous

3

Orange

Suspect

2

Green

Corrected

1

White

No Flag

0

By clicking on the Restore Original Data button then clicking within a data
field that has been edited (should be green, i.e. corrected) it will remove the
edit from the data and restore the data back to its original value.
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CHAPTER 6

Seabed QC Module

INTRODUCTION
The Seabed QC Module was developed to visually inspect the seabed sample
composition data collected by the RAN Hydrographic survey ships and to edit
and flag it appropriately. Figure 16 shows the main display of the module.

Figure 16 Seabed QC Module Display

Initially, all the seabed data is converted from CSV into Marine XML format
using XML Generator. The data is range checked and correspondingly
flagged as it is passed to XML. The following flag system is used:
AODC Quality Control Flags Version 1.0
No Flag - Original value
1 - Corrected value
2 - Suspect value
3 - Erroneous value
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Although the data has gone through initial quality control checks it is
impossible to truly check the data without visual inspection. Through visual
inspection the module allows data to be checked by comparison with
surrounding data points.

QUALITY CONTROL
The seabed composition codes are flagged if they are erroneous when they are
converted to XML format using the XML Generator. The Seabed QC Module
displays all the composition data in a table for the whole dataset. Three
columns in green (corrected), orange (suspect) and red (erroneous) make up
part of the table. Flags associated with a record are indicated by the presence
of a (*) in one of the green, orange or red columns.
Quality control of the dataset is achieved by scrolling through the table and
assessing whether there are any suspect or erroneous seabed codes that may
be modified by comparison with surrounding codes.
The format of the seabed composition code must obey the following rules:
1. All codes must be seperated by (.)
2. The descriptor code must precede the material code.
3. There can be more than one descriptor for a material or no descriptor.
4. The descriptors “f”, “m” and “c” can be used to describe Sand only.
Scrollable lists of the allowed seabed descriptor and material codes make up
part of the Seabed QC Module display.

EDITING DATA
CHANGING A DATA
VALUE

To change a data value you just double click on the relevant seabed
composition cell within the table. An edit frame is brought up on screen
(Figure 17).

Figure 17 Seabed Composition Edit Frame
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Once you complete all the details required in this frame and hit the SUBMIT
button the new value entered is checked for validity. If it passes the validity
test the field is updated. If it fails, you are asked to edit it again or cancel the
edit.
CHANGING A FLAG

To change a data flag all you need do is to double click in the relevant flag cell
and a pop-up menu appear asking if you would like to add or remove a flag.

RESTORING DATA TO
ORIGINAL VALUE

To restore data to its original value, just double click on the relevant seabed
composition cell within the table. If the data has been modified in any way
then the “Restore Original Data” button will be active. Hit the button and the
display and dataset will be updated with the original value.
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APPENDIX A

AODC Quality Control
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APPENDIX B

ThermalStructureOf
TheOceans

HORIZONTAL
TEMPERATURE
STRUCTURE

Ocean temperatures near the surface are strongly influenced by the regional
currents. Currents transport warm and cold water throughout the world’s
oceans. The circulation of the ocean’s surface waters is primarily wind driven.
Relative high horizontal gradients at the surface are indicative of significant
variations in oceanographic conditions. Some coastal regions of the world’s
oceans are affected by freshwater runoff from continents via major river
systems. Distinct temperature patterns also occur in regions of upwelling. The
sea-surface temperatures (SST) in these regions are colder than the water
surrounding such regions. Also, depending on the strength of the upwelling,
the sea-surface temperatures can be colder than what otherwise might be
expected. Another features of local SST characteristics are eddies. They form
independent clockwise and anti-clockwise circulations of cold or warm water.
The changes that take place in SST patterns can primarily be attributed to the
advection of cold or warm water brought about by the wind. Cross-current
wind causes warm or cold water advection, while wind that blows parallel to
ocean currents causes no advective change in the SST.

SEA SURFACE
TEMPERATURE

Ocean Sea Surface Temperatures (SST) vary from a low of -2oC in the high
latitudes to over 30oC in enclosed tropical waters. Deep and bottom water
temperatures are always low, ranging between 4˚C and 1˚C. The annual
variation of sea-surface temperature in any region is controlled by surface
heating or cooling, evaporation, precipitation, mechanical and convective
mixing. The annual range of surface temperature is much greater over the
oceans of the Northern Hemisphere than those of the Southern Hemisphere.
This wider range of temperatures is associated with the character of the
prevailing winds, particularly the cold winds blowing from the continents.
The annual range of ocean temperatures in the Southern Hemisphere is related
to the range of incoming solar radiation, as a result of the absence of large land
masses south of 45˚S. In the Southern Oceans the prevailing winds travel
almost entirely over water. This brings a far greater degree of consistency in
the annual sea-surface temperature patterns and a much smaller annual
temperature range compared to the Northern Hemisphere. Figure 18 shows a
satellite image (NOAA) of SST from NOAA satellite for the Australian
region.

Version 1.1

January 2002

MarineQC User Guide

Produced by AODC

29

Figure 18 Sea Surface Temperature Around Australia

Australian Western and Eastern coastal waters are dominated by two major
oceanographic features, the Leeuwin Current and the East Australian Current
(Figure 19).

Figure 19 Sea Surface Temperature off Australian Western and Eastern coast.
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THE LEEUWIN
CURRENT

The Leeuwin Current is a surface stream of warm, low salinity, tropical water
that flows southward, against the climatological mean equator-ward wind,
from northwest Australia to Cape Leeuwin and then eastwards towards the
Great Australian Bight. The Leeuwin Current varies seasonally in both speed
and permanence. The current is faster in late autumn to winter (May to
August) than in summer (December to March). Off the coast of Fremantle the
current appears to be present all year round. During summer the mean wind
stress along much of the coast is strongly northwards which contributes to a
weakening of the Leeuwin Current at this time.
The Leeuwin current generates both warm and cold core eddies on its seaward
side. The eddies penetrate to a maximum depth of about 300m. Temperature
fronts occur at the edges of the Leeuwin current and eddies. Temperature
differences of up to 5˚ C can occur on passing from colder water to the
Leeuwin current core. Temperature changes of approximately 3˚C will occur
on crossing the eddies generated by the Leeuwin Current. The Leeuwin
current and associated eddies are usually located east of 110˚E and between
26˚S and 35˚S. There can be significant mixed layer depths from autumn to
early winter, when layer depths can be isothermal down to 150m depth near
the centre of the current. Layer depths of up to 100m occur near the centre of
Leeuwin current eddies.

EAST AUSTRALIAN
CURRENT

The East Australian Current (EAC) system flows southward along the east
coast of Australia, dominating the oceanographic conditions of the Western
Tasman Sea. It transports Coral Sea Water of relatively high temperature (20˚
C - 26˚ C) and low salinity (35.4 - 35.6 parts ppt) from the equatorial region
southward into the Tasman Sea. Characteristic of the EAC path are its
temporal and spatial variability. The current is present at all times of the year,
but is generally strongest between December and April. The width of the
current is about 150km at its maximum. The EAC extends south from about
18˚S at its northern extreme sometimes as far as 42˚ S near Bass Strait at its
southern extreme.
South of approximately 32˚S large warm-core eddies are the dominant feature
of the EAC system. Figure 20 shows the thermal structure indicated by the
temperature isotherms at 250m depth of a warm core eddies.

Figure 20 Sea water temperature at 250m depth
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The eddies range in size from 150-250 km in diameter. The EAC eddies
maintain their water mass identities for many months, and in some cases
years. Figure 21 shows a temperature profile taken from an observation inside
an EAC eddy. These eddies are usually well mixed down to a depth of around
400m and may affect the thermal structure down to 1300m depth.

Figure 21 Deep isothermal layer inside East Australian Current eddy

VERTICAL
TEMPERATURE
STRUCTURE

The basic vertical structure of the ocean is generally divided into three zones
(Figure 22):
1. The Surface Mixed Layer
2. The Main Thermocline
3. The Deep Water Layer
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Figure 22 Typical Thermal Structure of the Oceans

Vertical temperature gradients are computed from the temperatures and
depths reported in BathyThermograph (BT) observations. The vertical
temperature gradients show the change in temperature over a given vertical
distance.
The annual variation of temperature in sub-surface layers depends on several
factors: the variation in the amount of heat that is directly absorbed at different
depths, the effect of heat conduction, the variation in currents related to lateral
displacement, and the effect of vertical motion. Of these three main layers, the
mixed layer is the most variable in its properties, primarily depth.
Another layer of high variability and of great importance in anti submarine
warfare is the sonic layer. The sonic layer is a layer that basically traps sound
waves. The Sonic-Layer Depth (SLD) is the level of maximum sound velocity
based primarily on temperature, but also controlled by density and pressure.
The sonic-layer depth and the mixed-layer depth (MLD) often coincide
(Figure 22).
THE SURFACE MIXED
LAYER

The mixed layer is the upper layer of the three-layered ocean model. It is a
layer of fairly constant warm temperatures which, in middle latitudes, extends
from the surface to a maximum depth of about 450 meters.
The thermal structure of the surface mixed layer exhibits characteristic
seasonal and regional variability influenced by meteorological conditions, and
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the depth of the mixed layer varies accordingly. During the winter months the
sonic layer depth is influenced by strong winds, high seas and weak solar
radiation which results in a great amount of mixing, producing a deep
isothermal layer up to 400 m. During summer, the winds are usually lighter
and the mixed layer does not usually extend as deep. Spring and autumn are
transitional months when the thermal profiles are more complex. The mixed
layer occurs between 5-100 m in low latitudes and 25-250 m in mid latitudes.
Below the mixed layer, very little mixing occurs. The depth at which mixing
ceases to occur is marked by the Mixed Layer Depth (MLD).
THERMOCLINES

The main thermocline is the central layer of the ocean. It is found at the base
of the mixed layer and is marked by a rapid decrease of water temperature with
depth. A thermocline is a relatively shallow feature whose depth is directly
influenced by the extent of vertical mixing.

THE SEASONAL
THERMOCLINE

At high latitudes there is no marked change in water temperature with the
seasons, while in the mid-latitudes, a seasonal thermocline develops in the
summer time (Figure 23). This seasonal thermocline may develop in the
surface layer up to about 200 meters depth from the gradual warming of the
surface waters.
The warming takes place in the upper water level, and results in the seasonal
thermocline becoming super-imposed on the main thermocline. In low
latitudes, small seasonal temperature changes make it difficult to distinguish
between the seasonal and the permanent thermoclines.

TEMPERATURE
Degrees Celsius

SUMMER

DEPTH IN METERS

SPRING
AUTUMN

WINTER

Figure 23 Upper level thermal structure of seasonal thermocline in middle latitudes

Version 1.1

January 2002

MarineQC User Guide

Produced by AODC

34
The structure of the seasonal thermocline will vary from year to year due to
variations in the strength and duration of wind and the amount of solar
radiation absorbed.
THE PERMANENT
THERMOCLINE

Beneath the surface layer is a region where temperature decreases rapidly with
depth.This is a transition zone between the warm surface layer and the cold
deep layer. Mixing and heat exchange takes place between the two layers in
this zone. It is a permanent feature at depths between 200-500m and 10001500m and is subject only to regional variations of depth and magnitude.

THE DEEP WATER
LAYER

The deep water layer is the bottom layer of water column in which
temperature decreases very slowly with depth. This layer is characterized by
fairly constant cold temperatures, generally less than 4˚C. At high latitudes in
winter, the water is cold from top to bottom. The vertical temperature profile
is essentially isothermal (no change in temperature with depth). Most types of
expendable BT probes are designed to measure the temperature versus depth
within the top 800 m of water column and they do not extend far into the deep
water zone.
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APPENDIX C

Marine XML DTD

This appendix outlines the proposed Marine XML Document Type
Definition (DTD). Some of the elements outlined below are new or have
changed compared to the XML format being used in the current version
of the MarineQC application. New or modified elements or attributes
are accompanied by a *.

The MarineDataSet element
<!ELEMENT MarineDataSet(QCDetails, property*,
MarineDataRecord+)>
<!ATTLIST MarineDataSet
Caveat(TopSecret | Secret | Restricted | Unclassified)
#REQUIRED
>
This element encases the whole of the dataset.
A MarineDataSet element consists of:
One QCDetails element (containing details of any qc tests etc.)
0 or more property elements (properties pertaining to the dataset)
1 or more MarineDataRecord elements (each record contains all the data for
one temporal and spatial observation)
Attribute Definitions
* Caveat
This attribute must be present in the element and has to have the value of either:
TopSecret
Secret
Restricted
Unclassified
Example
<MarineDataSet Caviat="TopSecret">
<QCDetails..................../>
<property......................./>
<MarineDataRecord....../>
</MarineDataRecord>

This element does not have to be present.
There can be any number of these elements.

The QCDetails element
<!ELEMENT QCDetails (QCProcess?) >
<!ATTLIST QCDetails
agency CDATA #REQUIRED
operator CDATA #REQUIRED
date CDATA #REQUIRED
tests CDATA #REQUIRED
status (Complete | Incomplete) #REQUIRED
>
The QCDetails element may or may not contain one QCProcess child element.
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This element contains details about quality control tests that have been undertaken on all the
records within this dataset.
Attribute definitions
All the following attributes are required.
agency
A reference to the institution that carried out the quality control tests on this dataset.
Usually an abbreviated version or acronym derived from the institutions name.
operator
The initials of the person who carried out the the quality control tests on this dataset.
date
The date and time that the quality control tests were undertaken on this dataset. This
is expressed as a ISO8601 date and time valid of the format mmm d, yyyy hh:mm:ss AM/PM
(eg Jun 4, 2001 4:20:20 PM)
tests
Reference to the quality control checks that were carried out on the dataset.
* status
Must have value either "Complete" or "Incomplete". When creating a dataset should
be set to "Incomplete". After passing through MarineQC should be set to "Complete".
Example
<QCDetails agency=”AODC” operator=”BR” date=”Jun 4, 2001 4:20:20 PM”
tests=”DuplicateCheck1.0” status=”Complete”>
<QCProcess.............../>
</QCDetails>

* The QCProcess element
<!ELEMENT QCProcess (Flags)>
<!ATTLIST QCProcess
name CDATA #REQUIRED
module CDATA #REQUIRED
>
The QCProcess element must contain one child element, Flags.
This element is used to contain information to define the quality control flags and the quality
control module used to process the data.
Attribute definitions
name
This defines the name of the QC Flags. ie: "AODC Quality Control Flags Version 1.0"
module
This defines the name of the QC Module used to quality control the data.
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Example
<QCProcess name="AODC Quality Control Flags Version1.0"
module="MetQCModule1.0">
<Flags......./>
</QCProcess>

* The Flags element
<!ELEMENT Flags (#PCDATA)>
The Flags element is used to contain the flags definition used by the QC Module.
Example
<Flags>Not Modified = 0; Corrected = 1; Suspect = 2; Erroneous = 3;</Flags>

The property element
<!ELEMENT property (#PCDATA)>
<!ATTLIST property
typeName CDATA #REQUIRED
>
The property element is used to set any property the user may wish. It has been put in to allow
flexibility within the Marine XML structure.
Attribute Definitions
typeName
This attribute is required. Used to identify the name of the property encased by the
property element.
Example
<property typeName="Project">Marine Monitoring Project</property>

The MarineDataRecord element
<!ELEMENT MarineDataRecord (description, sourceAgency,
property*, SpatialReference, TemporalReference, Source, QC,
Edits, AncillaryData, PrimaryData)>
<!ATTLIST MarineDataRecord
ID CDATA #REQUIRED
>
A MarineDataRecord structure consists of :
One description element (description of the data type)
One sourceAgency element (source agency details)
Zero or more property elements (property pertaining to an individual record)
One SpatialReference element (geo-spatial data)
One TemporalReference element (temporal data)
One Source element (source in terms of if it has been observed or not)
One QC element (pertaining to qc test results)
One Edits element (pertaining to any edits performed on data)
One AncillaryData element (containing data not taken primarily)
One PrimaryData element (containing the primary data)
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Attribute Definitions
ID
This attribute is required and identifies the number ID of the record.
Example
<MarineDataRecord ID="0">
<description............. ........ />
<sourceAgency................ />
<property.........................../>
<SpatialReference............../>
<TemporalReference........../>
<Source............................./>
<Edits.............................../>
<AncillaryData.................../>
<PrimaryData..................../>
</MarineDataRecord>

You can have none or more than one of this element.

The description element
<!ELEMENT description (#PCDATA)>
A simple description of the data described by the record.
Example
<description>XBT</description>

The sourceAgency element
<!ELEMENT sourceAgency (#PCDATA)>
A simple statement of who the source agency of the data is. ie: who acquired the data.
Example
<sourceAgency>RAN</sourceAgency>

The SpatialReference element
<!ELEMENT SpatialReference (GeoPoint | GeoBox | GeoLine |
GeoPolygon)>
A SpatialReference structure consists of one of the following elements:
GeoPoint
GeoBox
GeoLine
GeoPolygon
Contains a set of elements to describe the geographical coverage of the record. This is to
adhere to the Geography Markup Language (GML) 2.0 recommendation.
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Example
<SpatialReference>
<GeoPoint.........../>
</SpatialReference>

The GeoPoint element
<!ELEMENT GeoPoint (coordinates)>
A GeoPoint element contains one element coordinates.
The GeoPoint element is used to specify a single point in space.
Example
<GeoPoint>
<coordinates......./>
</GeoPoint>

* The GeoBox element
<!ELEMENT GeoBox (coordinates, coordinates)>
A GeoBox element contains two coordinates child elements.
The GeoBox element is used to specify a rectangle spatial region.
Example
<GeoBox>
<coordinates....../>
<coordinates....../>
</GeoBox>

* The GeoLine element
<!ELEMENT GeoLine (coordinates, coordinates, coordinates?)>
A GeoLine element must contain at least two and at most three coordinates child elements.
The GeoLine element is used to specify a linear spatial region.
Example
<GeoLine>
<coordinates....../>
<coordinates....../>
<coordinates....../>
</GeoLine>
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* The GeoPolygon element
<!ELEMENT GeoPolygon (outerBoundaryIs, innerBoundaryIs*)>
A GeoPolygon element must contain:
One outerBoundaryIs element
Any number of innerBoundaryIs elements
The GeoPolygon element is used to specify a region covered by a spatial polygon.
Example
<GeoPolygon>
<outerBoundaryIs......../>
<innerBoundaryIs........./>
<innerBoundaryIs........./>
<innerBoundaryIs........./>
</GeoPolygon>

Can contain any number of innerBoundaryIs elements.

* The outerBoundaryIs element
<!ELEMENT outerBoundaryIs (LinearRing)>
A outerBoundaryIs element must contain one LinearRing element.
Example
<outerBoundaryIs><LinearRing ........./></outerBoundaryIs>

* The innerBoundaryIs element
<!ELEMENT innerBoundaryIs (LinearRing)>
A innerBoundaryIs element must contain one LinearRing element.
Example
<innerBoundaryIs>
<LinearRing ......../>
</innerBoundaryIs>

* The LinearRing element
<!ELEMENT LinearRing (coordinates, coordinates, coordinates,
coordinates, coordinates*)>
The LinearRing element must contain at least 4 coordinates child elements, but it may have
more.
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Example
<LinearRing>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
<coordinates.........../>
</LinearRing>

There can be none or more than one of this element.

* The coordinates element
<!ELEMENT coordinates (X, Y)>
The coordinates element must contain:
One X element
One Y element
The coordinates element is used to specify a single point in space.
Example
<coordinates>
<X......./>
<Y......./>
</coordinates>

* The X element
<!ELEMENT X (#PCDATA)>
The X element must contain the x-coordinate of the point in space. In our case the longitude.
Example
<X>-36.51</X>

* The Y element
<!ELEMENT Y (#PCDATA)>
The Y element must contain the y-coordinate of the point in space. In our case the latitude.
Example
<Y>131.35</Y>

The TemporalReference element
<!ELEMENT TemporalReference (Instant | Period)>
The TemporalReference element must contain one of the child elements; Instant or Period.
This element is used to describe the temporal extent of the observations for the record.
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Example
<TemporalReference>
<Instant........./>
</TemporalReference>

or

<TemporalReference>
<Period............/>
</TemporalReference>

The Instant element
<!ELEMENT Instant EMPTY>
<!ATTLIST Instant
year CDATA #REQUIRED
month CDATA #REQUIRED
day CDATA #REQUIRED
hour CDATA #REQUIRED
min CDATA #REQUIRED
sec CDATA #REQUIRED
>
The Instant element must be empty.
The Instant element is used to specify a specific point in time in GMT.
Attribute Definitions
All attributes are required.
year
Four digit year of the observation.
month
Two digit month of the observation.
day
Two digit day of the observation.
hour
Two digit hour of the observation.
min
Two digit minute of the observation.
sec
Two digit second of the observation.
Example
<Instant year="2002" month="01" day="22" hour="12" min="57" sec="00"/>

* The Period element
<!ELEMENT Period (Start, End)>
The Period element must contain the following:
One Start element
One End element
Used to define the start and end of a period in time for which the observations were taken over
within the record.
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Example
<Period>
<Start......./>
<End......../>
</Period>

* The Start element
<!ELEMENT Start (Instant)>
The Start element must contain one child element, Instant.
Used to define the start of the period as an instant.
Example
<Start>
<Instant....../>
</Start>

* The End element
<!ELEMENT End (Instant)>
The End element must contain one child element, Instant.
Used to define the end of the period as an instant.
Example
<End>
<Instant........../>
</End>

The Source element
<!ELEMENT Source (MarinePlatform?, MarineAgency?, Sensor*)>
<!ATTLIST Source
isObservedData (true | false) #REQUIRED
sourceFileName CDATA #REQUIRED
>
The Source element must contain:
0 or 1 MarinePlatform element
0 or 1 MarineAgency element
0 or more Sensor elements
This element contains a number of attributes and potentially child elements to describe where
the data originated from. Where marine source is an abstract concept for describing the the
source of the data within this record. This can include details of instrumentation and the
platform for observed data or institution / citation details for data produced by a particular
organisation.
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Attribute definitions
isObservedData
Indicates whether the data is raw observed data (isObservedData = true) or is
processed data (isObservedData = false).
sourceFileName
Reference to the name of the file this data originated from before becoming a part
of the XML file (if applicable).
Example
<Source isObservedData="true" sourceFileName="T0_00001.RDF">
<MarinePlatform............/>
This element may or may not be present.
<MarineAgency............./>
This element may or may not be present.
<Sensor........................./> There may be 0 or more of this element.
</Source>

The MarinePlatform element
<!ELEMENT MarinePlatform EMPTY>
<!ATTLIST MarinePlatform
shipName CDATA #REQUIRED
callSign CDATA #REQUIRED
cruiseID CDATA #REQUIRED
>
The MarinePlatform element must be empty.
Contains details about a marine platform used to obtain observed marine data. This element
is used where data is acquired at sea.
Attribute definitions
All attributes are required.
shipName
Full name of the marine platform.
callSign
Call sign of the marine platform.
cruiseID
Reference identification for the cruise that this data was obtained on.
Example
<MarinePlatform shipName="MERMAID" callSign="VLRX" cruiseID="hi186mer" />

* The MarineAgency element
<!ELEMENT MarineAgency (property*)>
<!ATTLIST MarineAgency
Company CDATA #REQUIRED
Project CDATA #REQUIRED
Details CDATA #REQUIRED
>
This element is used to provide details of the source of the data not acquired at sea.
The MarineAgency element may contain 0 or more property child elements.
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Attribute definitions
All the attributes are required.
Company
This is the name of the company, business or organisation that observed the data.
Project
This is the project name.
Details
This can be any relevant details relating to the project the data was acquired under.
Example
<MarineAgency Company="AODC" Project="Marine Monitoring Project" Details="Seabed
Composition Component">
<property typeName="Project Officer">
Mr. Marine
There may be 0 or more property elements.
</property>
</MarineAgency>

The Sensor element
<!ELEMENT Sensor EMPTY>
<!ATTLIST Sensor
classification CDATA #REQUIRED
type CDATA #REQUIRED
model CDATA #REQUIRED
>
The Sensor element must be empty.
Contains information about the sensor used to obtain the data.
Attribute definitions
All the attributes are required.
classification
General classification of the type of sensor. Simple acronyms are recommended.
type
Any further details about the sensor.
model
Details to reference the sensor as a particular model.
Example
<Sensor classification="Sea Surface Temperature" type="Bucket Thermometer"
model="TS231" />

The QC element
<!ELEMENT QC (FailedQCTests*)>
<!ATTLIST QC
reject (false | true) #REQUIRED
details CDATA #REQUIRED
>
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The QC element must contain 0 or more FailedQCTests child elements.
Information describing the outcome for this record from the quality control tests that were
carried out on the entire dataset (described in the QCDetails element).
Attribute definitions
All attributes are required.
reject
Boolean value indicating whether record has been rejected entirely due to the
failure of fundamental quality control tests. This indicates that the record is either missing key
information or the key information provided is deemed to be erroneous to such an extent that
is cannot be salvaged and as a result casts the record as significantly unreliable.
details
If the reject attribute is set to true, then this text field is used to describe briefly the
reasons.
Example
<QC reject="false" details="" />
or
<QC reject="true" details="Warning on LandCheck1.0">
<FailedQCTests............./> Can have 0 or more FailedQCTests
</QC>

elements.

The FailedQCTests element
<!ELEMENT FailedQCTests (QCTestResult*)>
The FailedQCTests element must contain a sequence of 0 or more QCTestResult child
elements.
Example
<FailedQCTests>
<QCTestResult................./>
</FailedQCTests>

Can have 0 or more of the QCTestResult elements.

The QCTestResult element
<!ELEMENT QCTestResult EMPTY>
<!ATTLIST QCTestResult
test CDATA #REQUIRED
result (Fail | Warning | Pass) #REQUIRED
details CDATA #REQUIRED
>
The QCTestResult element must be EMPTY.
Attribute definitions
test
Reference to the QC test that created this result. (These QC tests are described in
the QCDetails element).
result
The result of the test is described by one of three outcomes (failed, warning or
passed) shown in this field.
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details
Free text describing the outcome of the test.
Example
<QCTestResult test="LandCheck1.0" result="Warning" details="It is possible that this
observation is based on land." />

The Edits element
<!ELEMENT Edits (EditedValue*)>
The Edits element consists of 0 or more EditedValue child elements.
This element is used to encase all the edits performed on observations within a
MarineDataRecord element.
Example
<Edits/>
or
<Edits>
<EditedValue................../>

You can have more than one EditedValue child element.

</Edits>

The EditedValue element
<!ELEMENT EditedValue EMPTY>
<!ATTLIST EditedValue
date CDATA #REQUIRED
editedBy CDATA #REQUIRED
object CDATA #REQUIRED
field CDATA #REQUIRED
originalValue CDATA #REQUIRED
reason CDATA #REQUIRED
>
The EditedValue element must be EMPTY.
Attribute definitions
All attributes are required.
date
This is the date the edit was performed.
editedBy
This is the ID of the person editing the data.
object
This is the type of data being edited. ie: XData, XDataDescriptive, etc.
field
This is the name of the parameter being edited. ie: Sea Surface Temperature
originalValue
This is the original value of the data before editing.
reason
This is a brief description of the reason the edit was performed.
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Example
<EditedValue date=”Nov 30, 2001 3:59:23 AM” editedBy=”AODC.br”
object=”SpatialReference.GeoPoint” field=”latitude” originalValue=”-19.045”
reason=”Warning on LandCheck1.0, Warning on RepeatObsCheck1.0, Failed
SpeedCheck1.0” />

The AncillaryData element
<!ELEMENT AncillaryData (DataObject+)>
<!ATTLIST AncillaryData
numOfObjects CDATA #REQUIRED
>
The AncillaryData element must have 1 or more DataObject child elements.
This element is used to contain all data that is not the primary data being collected.
Attribute definitions
numOfObjects
This is used to specify the number of data or consequently DataObject elements
contained under the AncillaryData element.
Example
<AncillaryData numOfObjects="2">
<DataObject............../>
<DataObject............../>
</AncillaryData>

The PrimaryData element
<!ELEMENT PrimaryData (DataObject+)>
<!ATTLIST PrimaryData
numOfObjects CDATA #REQUIRED
>
The PrimaryData element must have 1 or more DataObject child elements.
This element is used to contain all data that is the primary data being collected.
Attribute definitions
numOfObjects
This is used to specify the number of data or consequently DataObject elements
contained under the PrimaryData element.
Example
<PrimaryData numOfObjects="3">
<DataObject............/>
<DataObject............/>
<DataObject............/>
</PrimaryData>

Version 1.1

January 2002

MarineQC User Guide

Produced by AODC

49

The DataObject element
<!ELEMENT DataObject (XData | XDataDescriptive | XYData |
XYDataList)>
<!ATTLIST DataObject
id CDATA #REQUIRED
qcProcess CDATA #IMPLIED
>
The DataObject element must contain one child element that is one of the following:
XData
XDataDescriptive
XYData
XYDataList
The DataObject element is used to encase individual DataObjects and to identify the index
number of the object and the qcprocess used on the individual data object.
Attribute definitions
id
This attribute is REQUIRED. It identifies the number ID of the DataObject
element within the AncillaryData or PrimaryData elements.
qcProcess
This attribute is the name of the QCProcess used to QC this particular DataObject. It
should be the same as the attribute "name" specified for the element QCProcess defined
earlier.
Example
<DataObject id="0" qcProcess="AODC Quality Control Flags Version 1.0">
<XData................/> This element can be either XData, XDataDescriptive, XYDataList, XYData.
</DataObject>

* The XData element
<!ELEMENT XData (Parameter, Units, Data)>
The XData element must contain the following child elements:
Parameter
Units
Data
The XData element is used to specify one data value (double precision).
Example
<XData>
<Parameter........../>
<Units................../>
<Data................../>
</XData>
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* The XDataDescriptive element
<!ELEMENT XDataDescriptive (Parameter, Units, Data)>
The XDataDescriptive element must contain the following child elements:
Parameter
Units
Data
The XDataDescriptive element is used to specify one data value (string). Example
<XDataDescriptive>
<Parameter.........../>
<Units.................../>
<Data.................../>
</XDataDescriptive>

* The XYData element
<!ELEMENT XYData (xParameter, xUnits, yParameter, yUnits,
Data)>
The XYData element must contain the following child elements:
xParameter
xUnits
yParameter
yUnits
Data
The XYData element is used to specify one data pair (x, y) (double precision).
Example
<XYData>
<xParamater.........../>
<xUnits.................../>
<yParameter.........../>
<yUnits.................../>
<Data...................../>
</XYData>

* The XYDataList element
<!ELEMENT XYDataList (xParameter, xUnits, yParameter, yUnits,
QCStatus, Data)>
The XYDataList element must contain the following child elements:
xParameter
xUnits
yParameter
yUnits
QCStatus
Data
The XYDataList element is used to specify a series of (x, y) data pairs (double precision).
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Example
<XYDataList>
<xParamater.........../>
<xUnits.................../>
<yParameter.........../>
<yUnits.................../>
<QCStatus............./>
<Data...................../>
</XYDataList>

* The Parameter element
<!ELEMENT Parameter (#PCDATA)>
The Parameter element encases the name of the parameter measured.
Example
<Parameter>Sea Surface Temperature</Parameter>

* The xParameter element
<!ELEMENT xParameter (#PCDATA)>
The xParameter element encases the name of the x - parameter measured of the (x, y)
observation.
Example
<xParameter>Water Depth</xParameter>

* The yParameter element
<!ELEMENT yParameter (#PCDATA)>
The yParameter element encases the name of the y - parameter measured of the (x, y)
observation.
Example
<yParameter>Water Temperature</yParameter>

* The Units element
<!ELEMENT Units (#PCDATA)>
The Units element encases the units the parameter was measured in.
Example
<Units>Degrees Celcius</Units>
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* The xUnits element
<!ELEMENT xUnits (#PCDATA)>
The xUnits element encases the units used to measure the x - parameter of the (x, y)
observation.
Example
<xUnits>Metres</xUnits>

* The yUnits element
<!ELEMENT yUnits (#PCDATA)>
The yUnits element encases the units the y - parameter of the (x, y) observation was measured
in.
Example
<yUnits>Degrees Celcius</yUnits>

* The QCStatus element
<!ELEMENT QCStatus (#PCDATA)>
The QCStatus element is used to indicate whether the quality control on the observation has
been completed. A value of "0", the QC of this observation is complete. A value of "1", then
the QC of this observation is incomplete.
Example
<QCStatus>0</QCStatus>

* The Data element
<!ELEMENT Data (Observation+)>
<!ATTLIST Data
flagged (true | false) #REQUIRED
listLength CDATA #IMPLIED
>
The Data element must contain 1 or more Observation child elements.
The Data element is used to encase a series of observations for a particular data object.
XData, XDataDescriptive and XYData will only have one observation element. XYDataList
will have more than one observation element.
Attribute definitions
flagged
This attribute is required. It must be set to TRUE or FALSE. It is set to TRUE if the
data value has been flagged.
listLength
This attribute is not required if there is only one observation. Where the number of
observations is greater than 1, the listLength should be set to the number of observations. This
is the case for data type XYDataList.
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Example
<Data flagged="false">
<Observation............../>
</Data>
or
<Data flagged="false" listLength="2">
<Observation.................../>
<Observation.................../>
</Data>

* The Observation element
<!ELEMENT Observation (xValue, yValue?, flagID?)>
<!ATTLIST Observation
ID CDATA #IMPLIED
>
The Observation element consists of
One xValue element
One yValue element may or may not exist
One flagID element may or may not exist
The Observation element is used to encase either a x-value or (x-value, y-value) pair, along
with a flag, if required.
Attribute definitions
ID
This attribute is not required. It is only used for data of type XYDataList. Where it is
used it just identifies the index number of the observation within the data object.
Example
<Observation>
<xValue......./>
</Observation>

or

<Observation>
<xValue......./>
<yValue......./>
<flagID......../>
</Observation>

or

<Observation>
<xValue......../>
<flagID........./>
</Observation>

* The xValue element
<!ELEMENT xValue (#PCDATA)>
If data type is XData or XDataDescriptive the xValue element encases the value of the data at
the specific point in space and time. If data type is XYDataList or XYData the xValue element
encases the x value from the (x, y) data pair.
Example
<xValue>150</xValue>
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* The yValue element
<!ELEMENT yValue (#PCDATA)>
This element is only used for XYData or XYDataList data types. It encases the y value from
the (x, y) data pair.
Example
<yValue>23.5</yValue>

* The flagID element
<!ELEMENT flagID (#PCDATA)>
This element is only used if you wish to assign a flag to the observation. Flags should be
defined in the Flags element.
Example
<flagID>2</flagID>
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APPENDIX D

Marine XML File

Please note that this XML file is in the existing Marine XML format used with the MarineQC software. It does not conform
to the Marine XML DTD supplied in this manual and will be upgraded in the future.
<xml version="2.0" ?>
- <MarineDataSet Caviat="Unclassified">
- <QCDetails agency="AODC" operator="PS" date="Jan 22, 2001 1:20:25"
tests="DuplicateCheck1.0,RepeatObsCheck1.0,RangeCheck1.0,SpeedCheck1.0,LandCheck1.0">
</QCDetails>
- <MarineDataRecord ID="0">
<description>Mk12XBT</description>
<property typeName="sourceAgency">RAN</property>
- <SpatialReference>
- <GeoPoint>
<coordinates>20.566667,-156.9</coordinates>
</GeoPoint>
</SpatialReference>
- <TemporalReference>
<Instant year="2000" month="6" day="23" hour="9" min="14" sec="22" />
</TemporalReference>
- <Source isObservedData="true" sourceFileName="T0_00001.RDF">
<MarinePlatform shipName="HMAS ARUNTA" callSign="VKMQ" cruiseID="00020AR" />
<Sensor classification="XBT" type="T-10" model ="Mk12"/>
</Source>
- <QC reject="false" details="">
<FailedQCTests />
</QC>
<Edits />
- <AncillaryData numOfObjects="2">
- <DataObject id="0">
- <XYData>
<property typeName="xParameter">watertemperature</property>
<property typeName="xUnits">degreescelcius</property>
<property typeName="yParameter">waterdepth</property>
<property typeName="yUnits">metres</property>
<Data flagged="false">25.2, 0.0</Data>
</XYData>
</DataObject>
- <DataObject id="1">
- <XData>
<property typeName="Parameter">bathymetry</property>
<property typeName="Units">metres</property>
<Data flagged="false">80.0</Data>
</XData>
</DataObject>
</AncillaryData>
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- <PrimaryData numOfObjects="1">
- <DataObject id="0">
- <XYDataList>
<property typeName="xParameter">watertemperature</property>
<property typeName="xUnits">degreescelcius</property>
<property typeName="yParameter">waterdepth</property>
<property typeName="yUnits">metres</property>
<property typeName="qcDef">XBT-Mk12-AODC1.0</property>
<property typeName="yUnits">metres</property>
<Data flagged="true" listLength="321">24.895,0.63,0 25.035,1.26,0 25.115,1.89,0 25.11,2.52,0
25.111,3.149,0 25.117,3.779,0 25.113,4.409,0 25.121,5.039,0 25.126,5.669,0 25.119,6.298,0 25.12,6.928,0 25.122,7.558,0
25.12,8.187,0 25.129,8.817,0 25.122,9.446,0 25.126,10.076,0 25.123,10.705,0 25.125,11.334,0 25.123,11.964,0
25.12,12.593,0 25.117,13.222,0 25.125,13.851,0 25.122,14.48,0 25.12,15.109,0 25.123,15.739,0 25.12,16.367,0
25.127,16.996,0 25.123,17.625,0 25.126,18.254,0 25.126,18.883,0 25.124,19.512,0 25.126,20.141,0 25.129,20.769,0
25.131,21.398,0 25.123,22.027,0 25.126,22.655,0 25.122,23.284,0 25.125,23.912,0 25.123,24.541,0 25.124,25.169,0
25.123,25.797,0 25.125,26.426,0 25.123,27.054,0 25.123,27.682,0 25.122,28.31,0 25.123,28.938,0 25.124,29.566,0
25.121,30.195,0 25.126,30.823,0 25.128,31.451,0 25.126,32.078,0 25.123,32.706,0 25.123,33.334,0 25.128,33.962,0
25.122,34.59,0 25.124,35.217,0 25.123,35.845,0 25.124,36.473,0 25.123,37.1,0 25.126,37.728,0 25.127,38.355,0
25.125,38.983,0 25.125,39.61,0 25.116,40.237,0 25.119,40.865,0 25.122,41.492,0 25.115,42.119,0 25.109,42.746,0
25.107,43.374,0 25.101,44.001,0 25.099,44.628,0 25.095,45.255,0 25.09,45.882,0 25.092,46.509,0 25.088,47.136,0
25.078,47.762,0 25.072,48.389,0 25.066,49.016,0 25.063,49.643,0 25.063,50.269,0 25.059,50.896,0 25.054,51.522,0
25.051,52.149,0 25.05,52.775,0 25.046,53.402,0 25.05,54.028,0 25.043,54.655,0 25.046,55.281,0 25.049,55.907,0
25.045,56.534,0 25.042,57.16,0 25.044,57.786,0 25.044,58.412,0 25.041,59.038,0 24.986,59.664,0 24.927,60.29,0
24.892,60.916,0 24.808,61.542,0 24.702,62.168,0 24.603,62.794,0 24.512,63.419,0 24.445,64.045,0 24.348,64.671,0
24.26,65.296,0 24.198,65.922,0 24.141,66.547,0 23.971,67.173,0 23.885,67.798,0 23.8,68.424,0 23.764,69.049,0
23.73,69.674,0 23.698,70.3,0 23.632,70.925,0 23.598,71.55,0 23.586,72.175,0 23.581,72.8,0 23.578,73.426,0
23.571,74.051,0 23.567,74.676,0 23.555,75.3,0 23.539,75.925,0 23.504,76.55,0 23.464,77.175,0 23.434,77.8,0
23.407,78.425,0 23.39,79.049,0 23.381,79.674,0 23.35,80.298,0 23.315,80.923,0 23.287,81.547,0 23.269,82.172,0
23.254,82.796,0 23.228,83.421,0 23.176,84.045,0 23.141,84.669,0 23.118,85.294,0 23.089,85.918,0 23.049,86.542,0
23.02,87.166,0 22.995,87.79,0 22.974,88.414,0 22.967,89.038,0 22.961,89.662,0 22.962,90.286,0 22.964,90.91,0
22.962,91.534,0 22.965,92.157,0 22.954,92.781,0 22.954,93.405,0 22.955,94.029,0 22.955,94.652,0 22.953,95.276,0
22.944,95.899,0 22.911,96.523,0 22.853,97.146,0 22.808,97.769,0 22.773,98.393,0 22.739,99.016,0 22.717,99.639,0
22.7,100.263,0 22.691,100.886,0 22.686,101.509,0 22.662,102.132,0 22.624,102.755,0 22.606,103.378,0 22.602,104.001,0
22.59,104.624,0 22.586,105.247,0 22.587,105.869,0 22.582,106.492,0 22.584,107.115,0 22.561,107.738,0 22.494,108.36,0
22.418,108.983,0 22.322,109.606,0 22.233,110.228,0 22.162,110.85,0 22.091,111.473,0 22.067,112.095,0
22.059,112.718,0 22.049,113.34,0 22.04,113.962,0 22.039,114.584,0 22.035,115.207,0 22.034,115.829,0 22.035,116.451,0
22.031,117.073,0 22.026,117.695,0 22.008,118.317,0 21.999,118.939,0 21.988,119.561,0 21.976,120.182,0
21.959,120.804,0 21.958,121.426,0 21.949,122.048,0 21.941,122.669,0 21.929,123.291,0 21.92,123.912,0
21.918,124.534,0 21.902,125.156,0 21.873,125.777,0 21.849,126.398,0 21.818,127.02,0 21.79,127.641,0 21.773,128.262,0
21.744,128.883,0 21.724,129.505,0 21.706,130.126,0 21.7,130.747,0 21.698,131.368,0 21.686,131.989,0 21.668,132.61,0
21.663,133.231,0 21.653,133.852,0 21.616,134.473,0 21.556,135.093,0 21.424,135.714,0 21.304,136.335,0
21.204,136.955,0 20.866,137.576,0 20.612,138.197,0 20.495,138.817,0 20.435,139.438,0 20.406,140.058,0
20.382,140.679,0 20.349,141.299,0 20.33,141.919,0 20.321,142.539,0 20.306,143.16,0 20.296,143.78,0 20.292,144.4,0
20.287,145.02,0 20.283,145.64,0 20.289,146.26,0 20.286,146.88,0 20.283,147.5,0 20.279,148.12,0 20.274,148.74,0
20.281,149.36,0 20.281,149.979,0 20.278,150.599,0 20.28,151.219,0 20.282,151.838,0 20.274,152.458,0 20.283,153.077,0
20.279,153.697,0 20.26,154.316,0 20.245,154.936,0 20.234,155.555,0 20.221,156.175,0 20.212,156.794,0
20.215,157.413,0 20.183,158.032,0 20.097,158.651,0 19.973,159.27,0 19.891,159.89,0 19.83,160.509,0 19.691,161.128,0
19.576,161.746,0 19.529,162.365,0 19.466,162.984,0 19.415,163.603,0 19.31,164.222,0 19.215,164.84,0 19.128,165.459,0
19.1,166.078,0 19.021,166.696,0 18.947,167.315,0 18.915,167.933,0 18.889,168.552,0 18.869,169.17,0 18.836,169.789,0
18.767,170.407,0 18.707,171.025,0 18.663,171.644,0 18.647,172.262,0 18.639,172.88,0 18.639,173.498,0
18.625,174.116,0 18.62,174.734,0 18.614,175.352,0 18.598,175.97,0 18.592,176.588,0 18.575,177.206,0 18.555,177.824,0
18.551,178.441,0 18.534,179.059,0 18.516,179.677,0 18.498,180.294,0 18.476,180.912,0 18.472,181.529,0
18.456,182.147,0 18.435,182.764,0 18.429,183.382,0 18.418,183.999,0 18.405,184.617,0 18.385,185.234,0
18.336,185.851,0 18.271,186.468,0 18.228,187.086,0 18.166,187.703,0 18.111,188.32,0 18.069,188.937,0 18.06,189.554,0
18.011,190.171,0 17.904,190.788,0 17.842,191.404,0 17.814,192.021,0 17.784,192.638,0 17.759,193.255,0
17.738,193.871,0 17.707,194.488,0 17.651,195.105,0 17.62,195.721,0 17.559,196.338,0 17.472,196.954,0
17.415,197.571,0 17.371,198.187,0 17.21,198.803,0 17.128,199.42,0 17.069,200.036,0</Data>
</XYDataList>
</DataObject>
</PrimaryData>
</MarineDataRecord>
</MarineDataSet>
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